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Introduction to Blu Disc Studio Lite 
Everyone who is familiar with an end-user DVD authoring program and 
now wants to move up to do the same for bluray media, will be in for a 
surprise with Blu Disc Studio Lite. It is said to be intuitive for users. 
Depending on your background in authoring discs, it may be or may be 
totally the opposite. 

 
 

The end user DVD authoring applications are aimed at quickly producing 
a disc, taking many limitations and built-in features for granted. The 
home-made discs will not have the rich range of features that are seen 
on commercial releases. But most of us are satisfied with “dropping” in 
some movies, generating some chapters, adding a menu title and linking 
the menu to the movie and presto: the DVD can be burned and played in 
any DVD player. I personally hate the elaborate menus of some 
Hollywood discs that take forever and ever to end and take even longer 
to start viewing the movie itself: the main reason for having the disc. 

With Blu Disc Studio you won’t get far with the “quick and dirty” DVD 
authoring approach. Like the first DVD authoring programmes, you need 
to do a lot yourself instead of relying on “wizards” that do a lot for you, 
but also limit you in ways to do it. 

Blu Disc Studio is a highly flexible environment allowing the creation of a 
feature-rich bluray disc menus. But you can also skip all that and take a 
minimalistic approach with a simple menu to get to the movie as quick 
as possible. Blu Disc Studio allows you any implementation between 
these two extremes, but in both cases you need to author it yourself. 
And that can be a laborious undertaking. 

Depending on the version of the Blu Disc Studio family (Lite, Standard, 
MX, MX Pro, see www.blu-disc.net) more features are available. This 
document restricts itself to the free Lite. If it wets your appetite, the Lite 
version already has many capabilities and moving up the family tree will 
give even more flexibility whilst all versions will look and feel familiar. 

As one of the few authoring programs, Blu Disc Studio allows to include 
multiple audio tracks and multiple subtitles, each of them as an option 
to be heard or shown. These features are often forgotten by American 
products that ignore the fact that most of the world does not speak or 
write English only. Most have a single audio track and if subtitles are 
allowed, only one is used and is hard-burned as part of the final video 
image. None of this is the case with Blu Disc Studio Lite which is of 
European origin and recognizes the need of several audio tracks and 
subtitles.  

http://www.blu-disc.net/
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In addition it will not transcode the video or audio tracks but only “mux” 
them together. This process retains the original quality of the sources as 
any transcoding process reduces this – marginally or very visibly. The 
only requirement is that the video and audio tracks adhere to the bluray 
disc specifications. Many formats are not compliant (such as tv recorded 
interlaced “i” transmissions) and these will need to be transcoded into 
acceptable formats. 

Limitations in the “Lite” version 
Some limitations of Blu Disc Studio Lite that are lifted in the commercial 
versions are: 

 a maximum of 32 movies can be added to a project (commercial: 
no limit) 

 a maximum of 32 (popup) menus can be added to a project 
(commercial: no limit) 

 a maximum of 4 audio tracks per movie (commercial: 32, 
maximum of bluray specification) 

 a maximum of 4 subtitle tracks per movie (commercial: 32,  
bluray specification allows for 255) 

 drawing buttons: 1 way  (commercial: 8 ways) 

 no animation between menus or on pressing the “OK” button on 
the remote control 

 no playlists (no two menu options to “play all” titles as well as 
“play single title”) 

 no intro movie 

 no resume movie after stopping it 

 no 3D movies 

 no Scenarist export (although this product is discontinued 
anyway) 

A limit imposed on all Blu Disc Studio versions as menus are controlled 
through a Java implementation: 

 all images in all menus may together not exceed 7 900 000 
pixels. This limitation may require to re-use menu parts, texts or 
buttons. Re-use only counts once for pixel count. Part of the 
menu can also be moved into the background menu movie. That 
movie is not counted for any pixels. 

Flexibility at a (labour) cost 
The flexibility of Blu Disc Studio however, comes at a price. The Lite 
edition, as well as its more versatile commercial family members, 
requires you to think through the bluray disc creation process for the 
disc you want to make. Blu Disc Studio Lite (to be called BDSL from here 
onwards) only puts together the movies and menus in a bluray 
specification compliant manner. If either part is not compliant itself, the 
disc will be unplayable: 
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 proper files but with the wrong extension: those files are not 
listed in navigation windows and cannot be selected 

 files with the right file extension but which are improperly 
formatted: these can be selected and their incorrect nature will 
not show until much later – possibly only when you try to play 
the finalized disc. 

Many external tools exist to ensure your video, audio, menu and subtitle 
files comply. See section “Appendix C: External Tools” at the end if this 
tutorial for a list of possible contenders. 

Each bluray project consists of two elements that must be fully planned 
and made available: 

 the whole disc navigation structure:  
o items such as background videos or stills, menus, popup 

menus, buttons, sounds 
o actions on items: what happens if a button is clicked, an 

item selected, navigation between buttons, a menu 
replaced, playing order 

 the movie assets 
o video and audio tracks must be provided separately 

(demuxed) in bluray specification compliant formats, not 
as a combined movie-with-sound. Other formats are not 
accepted and need to be converted into acceptable 
formats outside BDSL. 

o Subtitles are provided in text based .srt or image based 
.sup format. Other formats are not accepted and need 
to be made compliant using external tools. 

 
Both parts can be set up independently.  
 
Menu navigation can be designed independently, using movie 
“placeholders” to point to the movies to be played. Those movies can 
be added at a later stage.  

The coverage by this tutorial 
This tutorial will only scratch the surface of the capabilities of BDSL but 
once you feel familiar with the bare necessities you may either be 
pleased and satisfied or will go on and explore the other options of the 
product to make Hollywood-style authored bluray discs.  

Once you’ve read it and made your own first disc projects, the online 
help of BDSL may start to make sense. As a starting point the online help 
files are very compact. 

1. This document starts by creating a simple disc with some movies 
that start playing immediately. No menu required. You use the 
remote control of your bluray player to select audio track, 
subtitle track or chapter of choice. 
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2. The next project and chapter is to add a menu to select which 
movie to play. The remote control still is used for selecting audio 
and subtitles or chapters.  

3. The final projects introduce menus with items that allow you to 
set those audio and subtitle tracks through selecting of an 
option on the menu. This can be done before the movie starts or 
while the movie is playing (then it is a “popup menu”). 
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Getting started: Blu Disc Studio Lite (BDSL) requirements 
This chapter discusses installation of BDSL and lists the requirements 
that disc components must meet in order to be acceptable as element of 
BDSL and be output to the final authored disc. If any component has a 
different format, you need to use a conversion tool to produce an 
acceptable format. See section “Appendix C: External Tools” at the end 
for tools that may be useful for this purpose. 

Blu Disc Studio Lite installation 
If you haven’t installed BDSL already, you can do so by downloading and 
installing the product from its website. The product only runs on 
Windows based systems from Windows XP upwards (at least upto 
Windows 10). It also requires Windows.NET V4 or higher. The free Lite 
version currently is the V1.0 commercial release of the product. It has 
become freeware whilst its further development turned into commercial 
family members (at time of writing in their V2.5 release). 

The download location is found at http://blu-disc.net/download.html. 
Follow instructions once you started the BDS_Lite_Setup_1.0.9.exe 
installation program.  

There is also a mute “Blu Disc Studio Quick Starter Guide in 10 Minutes” 
tutorial on YouTube as well as a paper instruction to go with it written by 
the author of this document and send upon request (email at 
theo.de.klerk@gmx.com). 

Obviously your pc must have sufficient horse power and memory to run 
the program and its large movie assets reasonably fast. It shows and can 
simulate menus but it will not play any movie title itself.  

Bluray disc capacity 
Whatever bluray disc project you try to create, the result must fit on a 
BR-25 single layer or BR-50 double layer disc. (See section “Disc 
capacity” in ”Appendix A: Bluray specifications” at the end of this 
document). 

 BR 25 can hold 23 866 Mb of data 

 BR 50 can hold 47 732 Mb of data 

Blu Disc Studio shows you the total size of your project (within 10%) on 
its toolbar at the far right end. There you can select between values of 
“1L” (single layer) and “2L” (double layer) capacity. Next to this label the 
toolbar shows the current size of the project as percentage of maximum 
size. If it is shown green, you’re in the clear, if it is yellow the project 
may be too large, if it shows red it is definitely too large. If you changed 
something in the project, clicking on the icon refreshes the information. 

If the size is too large (and only after muxing the project you know the 
exact size), you need to either reduce the size of some movies, remove 
some movies or re-encode the entire project result with a tool like BD 

http://blu-disc.net/download.html
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Rebuilder. Alternatively, moving from BR-25 to a double sized BR-50 disc 
may be the solution. 

 

The picture above shows a warning that a disc project may be a bit too 
big. The compiled version turns out to be indeed too big: 23.4 GB 
(25,226,452,992 bytes).  

Bluray disc player specification 
The bluray consortium specified how movies should be stored on bluray 
disc. Any other format may be supported by standalone players, but 
there is no guarantee. See “Appendix A: Bluray specifications” for a 
listing of these.  

Some tests on European bluray players showed all of them accepted 
23.976p, 24p, 25p, 29,97p, 30p, 50p, 59.94p. Using “progressive” instead 
of “interlaced” formats is the recommended option. 

Oddly enough any ripped DVD (creating .mpg files in interlaced format 
576i PAL or 480i NTSC) can be split into .m2v /.ac3 files using tsMuxer. 
Adding these files to Blu Disc Studio produces a bluray that works fine. 
So no need to make these movies progressive first. 

The mandatory playback capabilities for players are1: 

 Video decoder circuitry for MPEG-2, MPEG-4 AVC/H.264, and 
SMPTE VC-1 

o Encoded frame rates of 23.976, 24, 29.97, and 59.94 (25 
and 50 are optional) progressive 

 Audio reproduction capability for — 
o Dolby Digital (.ac3  AC-3), 640 kpbs, at least two 

channels (upto 5.1), 48 kHz sampling 
o DTS Digital Surround, at least two channels (.dts) 
o Linear PCM (.wav, LPCM) at 48, 96 and 192 kHz 

sampling, at least two (max. 7.1) channels 

 There are four optional audio formats for Blu-ray Disc — 
o Dolby Digital Plus (.eac3), up to 7.1 channels 
o Dolby TrueHD, 4736 kbps, up to 7.1 channels, 48 kHz 

sampling 
o DTS Surround  (.dts) 1509 kbps, 5.1 channels, 48 kHz 

sampling 
o DTS-HD Master Audio™, (.dts lossless) 3000 kbps, up to 

7.1 channels, 48, 96 or 192 kHz sampling 

The BDSL discs assume that the movies adhere to the above 
specifications. 

                                                           
1 from “Bluray Disc Demystified” chapter 7 “Players” 
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Blu Disc Studio Lite setup 
The Lite version does not have some elements present in the paid 
versions. This is outlined in the earlier section “Limitations in the “Lite” 
version” on page 7.  

BDSL project location 
Projects are configured through the menu option Tools > Options. Here 
you specify the location of the tsMuxer program that is required to mux 
the movies (it is not part of BDSL). Additional options can also be set like 
whether to use the project wizard for creating new projects. Several 
other options are best left to their setting until they get more meaning 
once you get familiar with the program. 

 

 

The same window also allows you to set a check at “Use JDK x64” in case 
you are running Blu Disc Studio on a 64-bits processor. 

The bottom part allows you to set the colour of any item you select and 
the colour of the navigation arrows in a “show navigation links” 
assignment when you want to see how buttons on a menu are 
connected with one another. 

BDSL Movies – picture requirements 
BDSL allows a maximum of 32 movies to be added to a project. When a 
movie is composed of various pieces, ensure that each section starts 
with a full frame (I-frame). When not, the transition from one scene into 
the next in the other section will show pixels and a stuttering picture. 

Movies need to be split into separate video and audio tracks. One video 
track can have several audio tracks (original, dubbed translation, editor 
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comments, music-only and such) and subtitles (in different languages). 
When a movie has a combined video/audio track, it must be demuxed 
into its component tracks. 

The acceptable movie file formats are given in the previous section 
“Bluray disc player specification”. They also must have the correct file 
type for BDSL to be seen in its menus: 

 MPEG-2 – file type m2v. These are PAL or NTSC interlaced SD 
(standard definition) formats (576i or 480i respectively). They 
can remain interlaced. (DVD rippers may produce .vob files that 
can be demuxed into a .mpv video file that can be safely 
renamed into .m2v) 

 AVC or H264 / MPEG-4  – HD (High Definition) with file type .264 
(some editors create files with H264 encoding and give them file 
type .mp4 which usually includes audio – the video part after 
demuxing can be safely renamed to .264 if the demuxer doesn’t 
give this file extension by itself) 

 H265 – with file type .265 = UHD files (Ultra High Definition or 
4K) 

 VC-1 – the SMPTE standard 421M video codec, based on 
Windows Media Video V9 – with file type .wmv  

The acceptable pixel ratios for these formats (with number of frames per 
second, always showing in 16:9 aspect ratio) are 

 Full HD  1920 x 1080  

 HD: 1440 x 1080  

 HD: 1280 x 720 

 SD: 720 x 480 – DVD format NTSC 
 
Many videos may not have the right aspect ratios from the start. Some 
video editors have default settings for different aspect ratios that may 
be different from what Bluray requires. Movies taken from YouTube or 
other internet sources or .mkv extracted files often only show the film 
pixels without black bars on top and bottom to compensate for the 
required 1280 x 1080 pixel aspect ratio.  If this is the case, you need to 
transcode the movies to bluray standards. This may also be needed if 
the source material is interlaced (as it needs to be progressive). 
 

BDSL Movies – audio requirements 
Acceptable audio formats on bluray are listed in the previous section 
“Bluray disc player specification”. 

BDSL Movies – subtitles requirement 
Subtitles can be added to the movies on disc. To be acceptable, they 
have to be made in either of 
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 .srt - the well known subtitle format which is a text file with time 
codes (that can be edited to fit any fps speed) 

 .sup – a transparent image with the subtitle as opaque image 
part. Basically it is a picture whose text cannot be edited (usually 
created when a ripped bluray .m2ts file demuxes .sup subtitle 
files). The tool “subtitle edit” can convert them into .srt by 
attempting to OCR the .sup images into text. 

BDSL Menu requirements 
Menus consist of background movies, images and buttons. Blu Disc 
Studio insists that the background is a (short) movie. It would be wise to 
create this – either as black silent short movie or containing the still 
background image of the menus. The background movie must be of 1920 
x 1080 pixels aspect ratio. Any other size may distort the final menu 
playback. The image(s) in the background movie do not count against 
the total pixel number (7 900 000) allowed for all menus. 

Menu texts, buttons and other visible elements are created from .png 
files. Like .gif files (that are not supported) the .png files allow for 
transparent parts instead of filling it with some default colour.  

The menu parts can be created separately or, using PhotoShop or other 
layered-image editor, as separate layers in a single .psd file. Importing 
such a file into BDSL will allow BDSL to create separate .png files from 
each layer and store it in a menu-specific folder of the project. 
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Using Blu Disc Studio and customizing it 
The Blu Disc Studio interface 

The BDSL interface has many elements that all are useful at some point 
in the project. To create a basic project you may use the wizard that is 
invoked through File > New. This will ask for a movie (with all its 
streams), the main menu (composed by a .psd file with layers or set of 
.png files) and popup-menus. Any element you do not have you simply 
skip by clicking on the “next” button of the wizard. Those missing 
elements are added later manually. The wizard sets up a basic project to 
which you can add any element at any later time. 

Alternatively, you just specify File > New and only specify project name 
and project folder and leave it at that for the moment. The required 
elements will be added later. 

The user interface of Blu Disc Studio looks a bit like the figure below – 
but this too can be customized to fit your needs. The option “View > 
Rearrange windows” provides some choices to quickly arrange the 
windows of the interface. 

 
 

We will build the project manually to make you familiar with the 
interface. There are various independent windows that show 
information of the project and allow you to modify it. These windows 
are made visible using the “View” menu option that lists the various 
windows. They can be positioned independently.  
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The default arrangement is helpful as most of the information required 
at some point in the authoring process is shown neatly together. 

In the sections that follow we will indicate what window to use. But for 
completeness sake the figure above shows all of them: 

1. Main menu and Toolbar - The area containing pull-down menu 
options and the bar that contains shortcuts to menu and other 
commands.  

2. Project tree - shows all menus, movies and playlists.  
3. Objects - shows objects of the selected menu.  
4. Properties window - shows properties for the selected menu, 

movie and graphic object.  
5. Designer window - shows the selected menu, where you can 

select objects and move them.  
6. Library window - shows graphic, video and audio assets to 

import in the project.  
7. Project structure window - displays an overview of the current 

project - a flow of menus and movies.  
8. Action matrix - used for copy actions, animations and highlights 

between buttons.  
9. Output window (basically used during compile/export).  

 

Step 1: Get organized 
When you’re an organized person you can skip this preliminary step as 
you obviously know where you put everything.  

But for all others: make sure you know where you get your stuff, where 
you leave your stuff and what you create in the middle phases. Making a 
mess of a project with elements all over the place and possibly with 
duplicate items, is guaranteed to create a nightmare for you. 

Basically “getting organized” means that you devise some project folder 
structure where everything is collected and where it can be found 
consistently. As a suggestion for a basic structure: 

\projectname 

    \output 

    \films 

    \imported_sources  

The toplevel \projectname is choosen when a new project is created. It 
cannot be renamed later (well… it can, but then the project needs to be 
re-created under that new name). 

You can subdivide the project folder in additional folders of course, like 
having demuxed movies, subtitles and (additional) audiostreams in 
separate subfolders of \films.  
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The \imported_sources folder can be used to store your PhotoShop 
layered .psd files or the flat (and mostly transparent) .png files that will 
be imported into the project for buttons and backgrounds. 

All of the folders can be referenced in the properties of certain project 
objects: 

 The \projectname is set when creating a new project through 
the New Project Wizard (through menu item File > New project 
or Ctrl/N). It asks first for the project name (e.g. “XXX”) and root 
folder to use (e.g. “D:\YYY”). Choose the folder carefully as once 
specified, it cannot be changed anymore! The wizard will then 
create the bluray project in specified root folder (e.g. 
“D:\YYY\XXX”). At times therefore it is handy to specify a project 
folder as D:\  which results in a project stored under 
D:\projectname. 
 

 
 

 The \output folder is specified in Project > Project properties > 
General tab. (SHIFT Ctrl/F11). BDSL uses \output as default 
name, but you can change it into anything else you fancy (such 
as “disc”). It is a folder under the project folder, and created by 
BDSL. 
 

 

 The \films folder you must specify in each of the movie 
properties for the streams “Video” and “Audio 1”, “Audio 2”, 
etc. If the movie has subtitles, it is also referenced in the “Sub 
1”, “Sub 2”, etc streams. Each movie can be stored in a folder of 
its own if you desire. The movies have to be demuxed in 
separate video and audio streams. 
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 The \imported_sources folder is specified when you create a 
new menu or popup as you specify the location from where to 
import the .psd layered file or the .png flat files for buttons. 

 
In addition to the mentioned user defined folders, BDSL will create 
additional folders of its own within the specified project.  
For example, BDSL creates a separate folder for each menu in the 
project. It will store the .png files created from the sources for menus 
and buttons when they are imported into the project. This is explained 
in the later section “Menu and button filename naming standards”. 

Step 2: Specify your languages 
For any audio or subtitle stream using a particular language, you need to 
ensure that language is part of the list of languages from which you can 
choose. By default BDSL has a short list of languages which reveals its 
east european origin.  

Set the required language codes by going to the main menu option File > 
Languages. The popup menu allows you to remove unwanted languages 
and add desired ones into the “Selected” column.  

The languages are listed by their name, not their code or country. So 
“Dutch” will be found under “D” and not under “N” for “Netherlands”. A 
checkbox allows you to sort the list in code-order. Then “nld” will be 
found under “N” for the Dutch language code. 

The most applicable language can be moved to the top of the selected 
list using the up/down arrow keys on the popup window. 
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The default language to use in a project is set in the Project Properties 
window (Menu Project > Project Properties) in its “General” tab 
indicating the “Default language code”. This will set any video, audio and 
subtitle track by default as being that language. You can still change this 
language assignment manually for each track. 

Step 3: specify the Java version to use for menus 
While you’re at it, you may also wish to change the BD-Java profile 
version to V2 in the same “General” tab. This allows for a larger total 
pixel size of all menus together (upto 7 900 000 pixels). 
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Project 1: Create the simplest bluray 
The project goal 

The goal is to produce a bluray that simply plays a movie directly after 
inserting it in a bluray player. And if there is a second movie, start 
playing that one after the first. When all is done, either you author it to 
start again (loop) or stop. 

No menus, no frills. But the movie has chapter points that can be moved 
to using the remote control buttons. 

Step 1 Create new project 
Before going to the next step, make sure you set up the BDSL program 
with your desired preferred settings as described in the previous 
chapter. 

A new project must be created first. Go to File > New and specify a 
project name (e.g. “MovieBD1”) and project folder (e.g. “D:\” if we want 
the project to be based as top level folder D:\MovieBD1 ). 

 

Click repeatedly on the “Next” button until you can click “Finish” to 
complete creating the project. The created project folder has the 
Project.bdmd file as BDSL project file and its backup .bak file (in case you 
make changes and decide not to save them).  

To be organized, the created folder D:\MovieBD1 is manually enhanced 
by adding the folder 

D:\MovieBD1\films 

where we will store all demuxed movie files. These consist of video, 
audio and subtitles. The resulting set of files is shown in the File Explorer 
of Windows as shown below. 

 

 

The resulting project has a minimum of entries, as the Project Tree 
window shows. 
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Step 2 Include the movies 
The movies to add to the project must be in bluray compliant format for 
each of its video, audio and subtitle streams. See section “Bluray disc 
player specification“ earlier. BDSL requires separate streams.  

The \files folder is populated with the movie files. We add two episodes 
of the 2015 animated tv series “Thunderbirds are Go”, called “Space 
Race” and “Crosscut”. The video files have file extension .264. There are 
two audio files for each episode (.ac3), one in Dutch (marked NL in the 
file spec) and one in English (marked UK in the file spec). There are also 
two subtitle files (.srt), again one in Dutch and one in English. 

 

During the disc building process the files of each episode will be muxed 
together into a single .m2ts file where video, audio and subtitles are 
combined. 

We now need to add the movie files to the BDSL project. For two 
episodes we require two movie placeholders in the project. 

To add a movie placeholder to the project go through these steps: 

1. Open the Project Tree window  (View > Project Tree  (F3)) 
2. Right-click on “Movies” and select “New Movie” (SHIFT Ctrl/V) 
3. Give a useful name to the movie you’re going to add and click 

OK (this will add the movie entry to the project window but also 
show it on the Structure window (F7)). In our example: “Space 
Race” is added. 
 
Each added movie is put into its own group. This is fine for now. Only when we 
want to set audio and subtitle tracks the same for all movies, they need to 
reside in one single group. 
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These steps suffice to add a movie placeholder. These placeholders are 
used to set up the entire menu navigation first. What movie is actually 
represented by this movie placeholder is specified by the placeholder 
properties. Because we don’t have menus in this project, we must 
continue to complete the movie properties by adding the file 
specifications of the video, audio and subtitles associated with each 
movie. 

4. Open the “Properties” window (View > Properties (F11)). This 
will show the properties of the movie title added. (In default 
project view this window is already shown). You may need to 
click on the “+” button next to “Common” if this part is collapsed 
and does not show the name of the movie or the group it 
belongs to. 

5. Under “Streams” select the video stream. This will show the “…” 
button at the far end at the right of the text line. Click on this to 
open a window to navigate to the compliant video stream.  

The file must have the right file extension (like .264) or otherwise 
it will not show and cannot be selected even if it is a proper file. 
An invalid file with the right extension can be selected but will 
cause problems later during the muxing and building of the disc. 
This may be the case if the file does not meet the bluray 
standards. So make sure the video file has a right format and the 
right extension. 

6. Repeat the previous step for any of the audio streams to go with 
the video and indicate the audio language. After “Audio 1” is 
used, automatically a blank “Audio 2” stream is shown for an 
additional language. Select the language code for each stream. 
The language codes to choose from are those you selected in 
section “Step 2: Specify your languages” on page 18 earlier. For 
your own sanity and that of the future viewer of your disc, keep 
the order of language tracks the same for all movies on the disc!  
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7. Repeat the steps for any subtitle stream. This will open a 
“Subtitles” window with a “File” selection box where the .srt or 
.sup files can be selected. You can indicate subtitle font, size and 
color. It can have a shadow (size 0 means no shadow) and you 
can specify the position (close to the bottom or higher up in the 
picture). And finally you specify the language of the subtitles. For 
your own sanity and that of the future viewer of your disc, keep 
the order of language subtitle tracks the same for all movies on 
the disc! Click “OK” to complete the settings.  

Note that for western languages with diacritical characters such 
as ä, ø etc, it is best to have these subtitle files in ANSI (Windows 
1252) format. Many subtitle editors output to UTF-8 which is a 
better choice, but in bluray subtitling using tsMuxer to mux the 
UTF-8 subtitles into the movie, diacritical characters come out 
wrong like “@R>”. This is caused by ANSI being 1 byte characters, 
UTF-8 uses multiple bytes. 

 

 

You now have added one movie (placeholder) with all its trimmings 
(properties) to the project. By repeating the previous steps you can add 
additional movies to the project, as long as the total size of the movies 
does not exceed the 25 GB disc capacity of a bluray BD-25 disc and 
leaves some room for buttons and (generated) java scripts and indices. 
Each movie has its own set of properties that specify what it is 
composed of. The properties of the movie “Space Race” is shown below 
in a separate window. The default project view has this window as part 
of the project view. 
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If by error you added an audio or subtitle track too many, you can delete 
it by selecting its row and pressing the keyboard <delete> key. If you 
want to rename the movie, simply select the “Name” field and type a 
new name. 

The Project Tree window will show all movies added. The branches for 
“Menus” and “Popup menus” remain empty.  

 

What comes after the first movie? 
In the movie properties of the first movie “Space Race” there is also an 
“End Action” property. Specify here what is to happen after the movie 
ends. In our simple case, we start the next movie, “Crosscut”. Click on 
the “>” button of the “End Action” line of “Space Race” and select the 
right action from the menu that is shown: in our case the action should 
play a movie and select which movie and what chapter (usually the first 
to start at the beginning). 
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Repeat these steps for all movies so that the end of one movie starts the 
playback of the next movie. The last movie to be played either leaves the 
“End Action” empty (disc stops playing) or specifies the first movie again 
in which case you created an endless loop. 

In addition there is a “Popup Menu” property entry. This is not used in 
our simple disc – there is nothing (no menu) to pop up. 

Step 3 Creating chapters 
Most movies allow you to jump forwards and backwards through its 
contents by defining chapters. These are called playmarks in BDSL. 

These playmarks can be manually defined or they can be generated 
automatically at almost fixed time intervals. You should always select “I” 
frames (complete pictures) as possible playmark. 

To generate playmarks, you revisit the movie’s Properties window. If 
closed, open it using View > Properties. The properties window shows 
the properties of any movie that is selected in the Project Tree window. 

There is always a playmark at the very start of a movie but you may 
want to add one at the very end of a movie. The latter allows the viewer 
to jump to the end of the movie by remote control and go to the next 
movie connected to the current one. 

In general any new playmarks are added to existing ones. You may want 
to set some manual playmarks before generating additional ones. The 
end result will be the sum of both sets of playmarks. 

Perform the following steps to create playmarks to the movie: 

1. Look for the “Scenes” property of the movie. Initially it will 
indicate “1” as the only playmark is the beginning of the movie. 

2. Click on the “>” button at the far end. This starts the indexing 
process that may take a little while (about 1 minute for every 10 
running time minutes) and creates a .idx and .inf file in the \films 
folder). If this process has been done before, the available 
information is opened quickly and shown.  
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3. The “Scenes” window of “Space Race” will show only one 
playmark if none were ever added before. 

 
4. By manually moving the slider underneath the picture, you can 

select a scene and make it a playmark by clicking the “Add 
playmark” (Ins) button. It is preferable to use the “>>” button in 
the menu bar to move to the next complete picture (“I” frame) 
before clicking the “Add playmark” button. 
Once set, it can be deleted by selecting it and clicking the 
“Delete Playmark” (Ctrl/Del) key. Instead of deleting a playmark 
and creating a new one elsewhere, you can select the old one, 
move the slider to the new position and click “Move selected 
playmark here” (Ctrl/Ins). All playmarks (apart from the one at 
the start) can be deleted by clicking “Delete all playmarks”.  

 
Proper positioning can be done using the “next frame” and “next 
I frame” buttons and play buttons on the left hand side of the 
menu bar. 

 

5. Playmarks can also be generated automatically. Generation is 
done by clicking the “Generate Playmarks” button (Ctrl/M). This 
opens up the “Generate playmarks” window where you can 
specify how many playmarks you want.  
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Between two playmarks a minimum amount of time is required 
(by the looks of it, of about 30 seconds). If too many playmarks 
are specified an error message is shown telling you too many 
chapters are specified or that the movie is too short for that 
number. This error never occurs on manual positioning of 
chapter marks. 
 

 
 
The “Scan Distance” rules the accuracy of the positioning. The 
larger the value (ranges between 3% and 49%), the more 
freedom BDSL has to position the marker according to the 
specified method. It is best to play with the settings to see what 
you like best. At 49% you will see that the chapter marks may be 
very unevenly spread out. Use 3% to position the marks almost 
at fixed intervals. 
The result is shown as set of playmarks under the video image 
and a list is shown to the right. Check boxes indicate whether 
the playmark will show up in a chapter menu (which we won’t 
make here, so it doesn’t matter). The end-of-movie marker 
should be unchecked. 
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When satisfied, you close the chapter window by clicking the 
“X” “close window” button at the top right hand corner. There 
is no other close mechanism. 

6. Note that upon generation you get always 2 more playmarks 
than specified: the one at the start and at the very end are also 
counted. This number is reflected in the final “Scenes” property 
of the movie. 

 
 

When you create playmarks, BDSL creates three index files (.idx, .idx.inf 
and .inf). The information in these files is used when showing the 
chapter marks later or when the disc is created.  

If for some reason you replace the video file (because of another resolution 
or bitrate), these index files are invalidated but not deleted. You must restart 
the playmark generation process (best to delete all playmarks first). Not 
doing so will open the playmarks window but all old playmarks are 
positioned strangely (on bit position which is incorrect when the movie is 
transcoded to a different bitrate) and the assumed playing time of the movie 
is incorrect. 

Step 4 Build the disc 

Final settings 
During the final build of the disc, BDSL requires all movies to have their 
chapter index files – even if it only has the start of movie chapter. If you 
never created them during authoring, the files are created during disc 
build. 

To create the disc, you have to specify the output location through the 
menu Project > Project Properties window (Ctrl Shift F11) using the 
General tab. 

 

The project is created by muxing all elements together into this output 
folder. 

You must also specify what item to play first once the disc starts playing. 
This is specified in the Project Tree view in the “First Play” box. Here we 
specify the first movie, “Space Race”. The [1] indicates starting at the 
first chapter (i.e. at the beginning of the movie). 
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The above view shows a single movie and this one is to be played first, 
starting at the beginning (the (1) indicates the first chapter). 

Creating the disc files 
The muxing starts by clicking the “Mux by tsMuxing” (Ctrl/F9) menu icon 

( ).  BDSL opens a progress window showing each step along the way, 
supplemented by additional come-and-go tsMuxer windows for each 
movie it muxes until done. This window is always shown on the default 
project view as the window in the bottom righthand corner. 

The first step re-runs the Simulator to ensure all files for the menus are 
present. This includes a check on the presence of all (menu) video, audio 
files needed for this. 

The next stage is the most time consuming: remixing the movies from 
their video, audio and subtitle files. This process can take upto almost an 
hour for a 50 GB double disc on a moderately fast pc.  

If during the muxing process you suddenly see very quick completion of 
lengthy movie files you can rest assured that some files for the muxing are 
missing (renamed, removed?). This will show at the start of the final step: 
the updating of the movie playlist. The dreaded uninformative “Line:0” 
error will show. All you can do is check each movie and menu item 
referring to files that do exist and are accessible. 

 

The final step is the “Updating movie playlist” which is rather quick and 
connects menu items with movies to play.  

It is in this phase also that “Line:0” errors may occur although the muxing 
process went well and those files are present in the output 
\BDMV\STREAM folder. In this case most likely one of the files that make 
up the movie (audio or subtitles) may seem corrupt to BDSL. The last 
movie listed in the “Updating” list is the culprit. See section “Possible 
problems – including “line:0” errors” on page 31 for more details. 
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The final window (project log window) indicates BDSL’s work done. 

 

There is one red coloured error that may be safely ignored in this 
project. It specifies that once the movie “Crosscut” finishes playing, 
there is no action to continue. The bluray disc will stop playing after the 
last movie has been shown. Which is what we want. If you want to 
return to the beginning and create an endless loop, the “End Action” of 
movie “Crosscut” can be set to play movie “Space Race” from chapter 1 
onwards. 

The bluray compliant file structure is written in the folder indicated in 
the Project Properties: 

 

with the actual video movies stored in the STREAM folder – just as large 
as their original source input (before they were demuxed). 
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Possible problems – including “line:0” errors 
The muxing of the final disc may encounter problems still that remained 
undetected earlier during simulations. The errors are mostly caused by 
incompatible movie files as that is the one thing Blu Disc Studio does not 
check during authoring. 

 “The system cannot locate the object specified. Line: 0” – audio 
This error may occur when a movie has the LPCM audio 
(uncompressed) mode rather than Dolby .ac3 or DTS. This error 
should not happen but if there is an LPCM audio track, transcode 
it to Dolby and try again. 

 Movie remains black – sound audible, no subtitles seen. 
This error may occur when a movie is not meeting the bluray 
aspect ratio criteria. It must be 1920x1280 or 1280x720, 
720x480 pixels or other allowed aspect ratio. Some YouTube or 
.mkv movies have different aspect ratios eliminating top and 
bottom black bars (letterbox) that are required to fill the bluray 
allowed ratios. Transcode the movie to a proper ratio and try 
again. The movies must also be progressive and not interlaced. 

 “The system cannot locate the object specified. Line: 0”  
The muxing of the movies will succeed (and the 
\output\BDMV\STREAM folder will contain the .m2ts files with 
all audio and subtitles muxed), but the final step of the building 
will fail. This is when the muxing progress window starts its 
“Updating….” phase. The movie mentioned last before the 
process is stopped and the error message is shown, is the one 
where BDSL found a problem. 
BDSL tries to compose its menus and provide links to movies or 
their audio and subtitle tracks. For some reason or other it 
cannot link to (one of) these tracks and then fails. Without 
telling you what link it cannot create. 
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This problem can only be figured out by trial-and-error and some 
deductive thinking. The problem lies in either: 

 movie file is not in bluray specification aspect ratio 

 audio file(s) are corrupt  

 subtitle file(s) are corrupt 

 one or more files listed in the properties of the movie do 
not exist (were renamed, deleted or made inaccessible) 

To figure out the problem: 

 save the current project under a different name 

 start removing all movie files but the offending one 

 remove the item you suspect (audio, subtitle) and remux 

 if the error still occurs, remove another item 

 if success, the removed item must be re-made: 
sometimes a simple opening and explicit closing (save-as 
instead of “save”) does the trick. For subtitles you may 
wish to save in Windows 1252 format instead of UTF-8 
or something else currently used 

 Go back to the original project and remux. If the 
offending file is corrected, it should now complete 
successfully unless further down the line another movie 
has offending parts 

Step 5 Test running the disc 
You can now play the disc. Either by taking your chances, burn it and 
play in it a standalone player. There are rewritable discs for this 
purpose., Or by first checking it with a software player on your pc. This 
allows you to correct any missing items or wrong behavior without 
actually losing a write-once bluray disc. 

Keep in mind that all movies and their tracks must comply with the 
bluray standard if you want to be sure they play in any standalone 
player. 
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The total size must also not exceed either the 25 GB or 50 GB capacity of 
a bluray disc. If it does, some items must be removed from the disc, 
compressed tighter or… you may rebuild the entire disc using a 
“recoder” program such as BD Rebuilder or Nero Recode. This squeezes 
all elements as much as needed to make the entire disc output fit on the 
desired disc size. This squeezing comes at the price of stronger 
compression and some loss of resolution. 

ISO image 
Some software players only accept an .iso image of the disc or a real disc 
to play. In both cases an .iso file is needed as container of all bluray files. 
Instead of a real disc you can use a disc emulator to create a new bluray 
station (such as Y:\ ) from the .iso file. Virtual CloneDrive is such a 
freeware program).  

To create this, you can use  

 Nero BurningROM: set device to “image recorder”, use the BD 
Video templates and select “Blu-ray (iso)” option. Drag the 
\output folders to the Disc Content region. 
 

 
 

 ImgBurn freeware software (select “Create image file from 
files/folders” from the mode EZ-Picker). The BDSL produced 
\output subfolders \BDMV and \CERTIFICATE are specified as 
starting folder, using data type Mode1/2048, UDF 2.50 file 
system, recurse subdirectories). Indicate a location to write the 
MovieBD1.iso file to. 
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Test run using software player 
Not all software players seem to be fully reliable to play a bluray disc. 
Some do one aspect better than others, the expensive ones I did not try: 

 Leawo bluray player: only runs from (virtual) discs. It doesn’t 
show menu and does not allow to select or change audio or 
subtitle tracks. Starts playing a track and not any other. 

 Nero 12 Bluray player (discontinued product) – doesn’t display 
some video track correctly from the bluray disc folder or as .iso 
image. It has a problem showing interlaced video but works fine 
for progressive video (1080p, 720p) as well as DVD 576i. 

 VLC: runs only (virtual) discs. Allows right-click change of audio 
or subtitle track. Through its “Title” you can select another video 
track. It does not show menus. Clicking on its menu button starts 
first video track from the main menu. 

 Cyberlink PowerDVD 12  OEM edition – show menus. Allows to 
open the bdmv\stream files, change audio track but doesn’t see 
any subtitle tracks.  

 Cyberlink PowerDVD 15 – rather expensive program for “just” 
playing back bluray and DVD discs – being restricted by the DVD 
or Bluray regional setting (that’s not a problem for your own 
created discs that by default are “region free”). 

Step 6 Burn the bluray disc 

Test run using a standalone player 
The ultimate test is to burn a Bluray disc .iso file or the \output folder of 
BDSL to a BR-25 or BR-50 (re)writable disc and upon completion play it in 
a “real” bluray player. Rewritable discs are preferred if you test the disc: 
they can be reused after changes have been made until the disc is to 
your satisfaction. 

To burn the disc you can use Nero BurningRom or freeware ImgBurn. 

 Nero 12: use the “Bluray” templates and select “BDMV video” 
template. Upon opening, drag the folders in BDSL \output folder 
in the file browser to the disc content left hand part of the 
interface. 

 
 

This may produce some warnings that can be ignored as the 
burned disc will play: 
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To avoid these warnings, you can also burn the disc folder using 
the “Blu-ray” option, select the “Blu-ray (UDF)” template, select 
the UDF tab at the right and select “manual settings” and 
indicate “physical partition” and “UDF 2.50”. UDF 2.5 is the 
official standard partition format for bluray discs. 

 

 

Once the “Disc Content” window opens, you drag the two main 
folders BDMV and CERTIFICATE from the File Browser area to 
the disc content area and start the burn process. 
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Note: It is my impression that using this UDF V2.50 method 
produces a disc that switches much quicker between menu 
items and movies than the disc made using the BDMV template.  

 ImgBurn:  select “Write files/folders to disc” (if this does not 
show, select the menu option Mode > EZ-mode picker). From 
the next screen: 

o select the “Options” tab and fill in the Image Options 
box with: 

 Data Type specify “Mode 1/2048” 
 File system UDF 
 UDF Revision: 2.50 

o select the bluray drive in the “Destination” field 
o check the “verify” box if you want to check the disc 

burned. 
o Select the “labels” tab and specify a disc label. 
o Burn the disc 

 

Step 7 Problems with the final disc: some possible solutions 
Running the created disc with a software player may uncover most 
navigational errors in the menu transitions. These can be corrected in 
BDSL and the entire disc can be recreated and re-checked. 

Sometimes one or more of the videos may not show properly, either 
using a software player or a standalone player. Check if your video for 
the following: 

 are all video files muxed to the standards that all players must 
support (see the section “Bluray disc player specification” 
earlier)?  If not, correct this and rebuild the disc. 

 does a software player not show subtitles and you did include 
them? Try opening the movie file from the 
\OUTPUT\BDMV\STREAM\*.m2ts file and play it using a video 
movie player like VLC (the sequence number should be its 
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position in the movie list of the Project Tree view or the BDID 
number listed during muxing). If that does show the subtitles, 
nothing is wrong. If not, you need to find the reason why 
subtitles are not included in the muxed movie file. 

 if the movie seems jumpy, does the video have a stable time 
base? Often these problems can be solved by using TS Doctor to 
recreate the .ts or .m2ts source file without making any changes 
to the source. It will provide a new time base. If necessary 
transcode the resulting file to bluray standards and finally 
demux the file into video/audio components for BDSL and 
rebuild the disc. 
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Project 2: Creating a simple menu-driven bluray disc 
The project goal 

This chapter will show how to make a simple bluray disc with a static 
menu showing the titles of the movies contained on the disc. By using 
the remote control arrow keys you switch between the various movie 
titles and select one. By pressing on the “OK” or “Enter” key, the 
selected movie plays. At the end, the menu is shown again. 

Selection of any audio or subtitle track is done via the remote control 
buttons for this purpose. You can also shift to previous and next 
chapters using these buttons. They are not selectable through a bluray 
menu displayed on screen. That is postponed to the next chapter. 

This project extends the previous one by: 

1. adding a full screen menu shown at startup 
2. use buttons with “Normal” and “Selected” states 
3. add navigation between and action to buttons 
4. use a single button as prototype of all buttons 

What you need to know about menus and buttons first 

Menu background video 
BDSL insists that the very lowest menu background is a movie. If you 
don’t want this (as we don’t really need it in this simple disc build), it still 
has to be there. Create a small movie of pixel size 1920 x 1080 and make 
it entirely black with no audible (silent) sound track. It will show itself as 
an entirely black screen. On top of this we can add menu pictures and 
the buttons. 

The background movie must be 1920x1080 pixels in size. Any other 
will deform the final menu as shown on screen. 

We experienced some problems if the (silent) audio track was 
LPCM (.wav) formatted – use Dolby Digital (.ac3) instead. 

Alternatively, you want some music playing while the background is 
shown as still image. In that case, add the still image or black video with 
a music audio track as the video/audio track on all menus that are 
related through button jumps. Switching between menus lets the music 
continue to play and doesn’t start again with each new menu. 

Menu image 
One part of a disc image is composed of some inactive images. These 
can be picture or text. If part of the menu must look like a movie, that 
part must be implemented in the menu background movie. A movie 
editor must be used to do this. If only some part of the menu should 
show a moving image, the background movie must still provide the 
entire 1080x1920 pixel area. However this can be entirely black apart 
from the small part that is showing the moving image. Commercial discs 
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often have a moving background menu movie on top of which text and 
buttons are shown. 

Menu buttons 
The other part of a menu consists of buttons. Using the remote control 
you navigate between buttons to select your choice from the list of 
options shown on the static menu text.  

In fact, while navigating between buttons you do not move the button, 
you often make one button invisible (or dimmed) and the next one 
visible (or highlighted). That looks to the eye as “moving the button”.  

Each possible option on your menu has one button which is be in one of 
four possible states: 

o normal 
o selected 
o active 
o current 

Only the “Normal” and “Selected” states are required for 
implementation. The other two states are “nice to have” but not 
essential. 

Normal 
The “Normal” state shows the button when it is not selected. When a 
menu offers 10 choices, 9 of them will have a button showing its 
“normal” state and only one in the “Selected” state.  The “Normal” state 
is always visible (unless transparent). Other button states are shown on 
top of the normal state image.  

Note: Any non-normal state image of a button therefore must cover the normal 
state image. If such a state has a transparent part, the Normal state image can be 
seen through this transparent part. 

The “Normal” state can be a dimmed version of the “Selected” state, but 
often it is totally invisible. This means that the “Normal” state .png file 
(or corresponding PhotoShop file layer) is totally transparent (but those 
pixels do count against the total pixel count allowed). 

Selected 
The “Selected” state will always be a visible state of the button. It can be 
a bright arrow or some other indication of what menu item you 
currently selected using your remote control. Its image differs from that 
of the “Normal” state in order to highlight the selected button. 

Normal and Selected states of buttons on menu 
In the figure below a small menu item is shown as static black image 
with white text. At the left of the text the “Normal” state of four buttons 
is shown. Often this state is transparent. Here we choose to make them 
gray outline circles so they can be seen. 
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The same buttons are shown again, but now their “Selected” state. 

 

Notice that all four buttons have a “Selected” state looking like a yellow 
circle with arrow. When the bluray plays, only a single button will show 
its “Selected” state while the other three show their “Normal” state.  

For example, if you navigate to the third option on the list, the menu on 
a player would look like the image below. 

 

By using the remote control and moving the selection upwards or 
downwards, other buttons will become “Selected” and show their 
yellow arrow circle, while the current third one reverts from yellow 
“Selected” to its  grey “Normal” state showing the gray outlined button 
“Normal” state again. 

Activated 
The other two states are not needed and will never show. However, if 
you do implement an image (.png file) for the “Activated” state it will 
briefly show this button state if it is currently selected and you decide to 
press the “OK” button on the remote to activate this selection. This is 
the case if you want to show the indicated movie or jump to the 
specified menu. The Activated state has little use in BDSL other than 
briefly changing the button state image. It is more useful if this state is 
associated with a gradual change of the menu before the movie starts. 
However, these “playlist” like features are not available in the Lite 
version. 

Current 
The “Current” state is most useful in type of menus where you pre-set a 
choice in language or subtitle. The “Current” state of a button will show 
up if that choice was made on a previous visit to the menu. It reminds 
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the viewer what the current setting (choice) for the audio track or 
subtitle track is. Using the navigation buttons on the remote you can still 
move through all options on the menu – changing a button state 
between “Normal” and “Selected” state as before.  

When exiting the menu without activating any button, the current 
choice remains. When activating (pressing OK) a new selection, then this 
selection becomes both Active as well as the new “Current” state. 

The image below gives you the same menu list as before, but with 
button state “Current”: a red circle with arrow for each of the four 
buttons. 

 

When “Nederlands” is selected (3rd button) using the remote control the 
button state will become “Selected” and shows a yellow circle. 

 

When activated (by pressing “OK”) as preferred choice, the Dutch 
language track will be activated and set as the new current one.  

Revisiting this menu later, the choice is remembered showing the button 
near “Nederlands” as “Current”. You can still change your selection to 
“English” showing the yellow circle. 

 

If you press on “OK” on the remote, the English audio will become 
current. If you exit without changing your choice, the Dutch track will 
remain current. 

The useful thing about these “Current” settings is that once made, the 
choice applies to all movies that belong to the same movie group. The 
group name is listed in the button property list. This way you only 
specify the setting once and it applies to all movies in the group. 
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When all movies on the disc belong to the same group, you only need to specify 
audio track or subtitle track once, and it applies to all movies in the group. 

The button properties indicate this, as we will show in one of the later 
projects. 

 

In the figure above the properties of the third button are shown during 
BDSL development. Its navigational properties are indicated in the 
“Actions” properties and show what happens if you press the up, down 
or OK (Enter) button on the remote control. The “Highlight” section 
comes into play when a current state is defined for the button. Here it 
states that the “Current” state of the button must be shown on screen if 
the third subtitle is selected and activated previously. It will apply to all 
movies that belong to the movie group “WestSideStoryMulti”. This 
means that any movie belonging to a different group is not affected. This 
may be the case for a bonus or extra movie that does not have a Dutch 
subtitle and therefore no 3rd subtitle track or possibly it has a different 
language on the third track. 

The “Highlight” section is automatically filled by BDSL when a Current 
state is defined for a button, but you can change the settings if you like. 

Menu image size 
The total number of pixels allowed in all menus together is limited to 7 
900 000. This is a BDS limitation for both free and commercial versions 
and has to do with the Java implementation of menu navigation. The 
size may increase in a future edition. 

Menu images are created with image editors that can produce .png 
images (this format also allows transparent pixels to allow “a hole” in a 
menu where the background movie shines through). 

Alternatively, rather than single .png files, a layered image editor such as 
PhotoShop can be used. When a .psd layered image is imported into 
BDSL, the layers are converted into single .png files and stored in a 
menu-specific folder of the disc project. 

Because of the maximum number of pixels for all menus together, it is 
wise to show restraint in making large sized menus and re-use elements 
where possible. With four full-sized 1080x1920 pixel images you already 
exceed this limit. 

If your have three or less of such screen filling images, they will remain within 
this maximum number of 7 900 000 pixels. Together with the menu buttons 
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the pixel number may still be below the maximum number and you may not 
have to worry about trying to economize on pixels. 

Menu images are always rectangular, regardless whether there is a 
visible picture in the entire rectangle or that part of it is transparent. 
Transparent pixels count as pixels. The most efficient way of filling 
menus is by using rectangular blocks showing what it needed (image or 
text) but do not occupy any needless space. Better to use 5 small 
rectangles filled than one big one covering the same area but with 
“empty” holes in it. 

To visualize this, examine the two figure below. The first menu consists 
of 3 small rectangles. 

 

 

The pixels of all 3 rectangles count against the total of 7 900 000 pixels. 
The checkered background is “transparent” and will show the 
background menu movie. Those transparent parts do not count as menu 
pixels. 

 

The second image incorporates all three parts into a single rectangle, 
part of which is made transparent. The entire rectangular area, including 
the transparent pixels, counts against the 7 900 000 pixels – much more 
than the three coloured rectangles by themselves. 
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You can check on how many pixels are used as all menu images are 
stored in the final bluray disc output folder as a Java .jar container in 
folder \BDMV\JAR\00000.jar.  If you rename this file to 00000.zip and 
open it, the zip container will show an m1.png file which contains all 
pixels of all menus. You can extract it or open it with an image editor to 
see whether its total size exceeds the current limit of 7 900 000 pixels.  

The .png files for menu images or (states of) buttons must adhere to 
specific naming conventions for them to be recognized as image or 
button. This is also true if the .png files are made up from layers in an 
image file created by PhotoShop. Anything not adhering to the naming 
convention automatically becomes an (inactive) menu image part. 

Menu images and buttons as Photoshop layers 
Menus and buttons can be combined in a single layered image files. 
These must be 32-bits files (8 bits per layer of which there are 4). 

Layers for a single button must be named “btn:name:state” where the 
name is some unique name for the button and state is one of “N” 
(Normal), “S” (Selected), “C” (Current) or “A” (Activated).  For example 
“btn:MainMenu:N” is the normal state of a button named “MainMenu”.  

One .psd file can contain many buttons, each with their own set of layers 
– one for each state a button can be shown in.  

Menu and buttons as separate flat image files 
Any image editor producing flat files is acceptable, provided it can 
output files with transparent backgrounds as 32-bit .png files. The 
commonly used .jpg, .tif, .bmp or .gif and other file formats for images 
are not acceptable to BDSL. 

Menu and button filename naming standards 
Files that make up (the states of) a button must adhere to a strict 
naming standard. In all other cases these files are considered images.  

When a .psd file with button layers is provided, the layers must stick to 
the layer naming standard. 

In both cases, BDSL will create a separate folder in its project directory 
and insert .png files for each of the specified .png files or creates .png 
files from the PhotoShop layers. The names BDSL uses to create its .png 
files is (slightly) different from the ones you are required to use as 
“source” for the menus. 

The table below lists the names of the .png files you create and those 
that in the end BDSL creates in its menu folders. As example, a user 
created file “MyButton_normal.png” ends up in a menu specific folder 
by BDSL created name “btnMyButtonN.png”. 

state name postfix + file type 

normal file_name _n.png 
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_norm.png 
_normal.png 
.png   (no postfix) 

BDSL creates: btn<filename> N.png 

selected file_name _s.png 
_sel.png 
_select.png 
_selected.png 
_selection.png 

BDSL creates: btn<filename> S.png 

activated file_name _a.png 
_active.png 
_action.png 
_activate.png 
_activated.png 
_press.png 
_pressed.png 

BDSL creates: btn<filename> A.png 

current file_name _c.png 
_cur.png 
_curent.png (spelling error!) 
_current.png 

BDSL creates: btn<filename> C.png 

 

When you provide menu and buttons as layers in a PhotoShop .psd file, 
the output is listed in the table below. As example, a user created file 
“MyMenu.psd” with many layers (the background images as well as one 
layer for each of the states of each button) ends up in a menu specific 
folder by BDSL with one .png file for each button and button state plus 
the background images. For example, the Normal state image for the 
button MyButton which is defined in layer btn:MyButton:N is stored in 
“btnMyButtonN.png”. 

state layer name postfix + file type 

normal btn:name:N  

BDSL creates: btn<name> N.png 

selected btn:name:S  

BDSL creates: btn<name> S.png 

activated btn:name:A  

BDSL creates: btn<name> A.png 

current btn:name:C  

BDSL creates: btn<name> C.png 

   

Quick corrections once you get the hang of BDSL 
Making modifications to an existing menu can be done quickly if you 
modify the .png file in the BDSL created menu specific folder of the 
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project rather than your original source files. If the following sounds like 
“acracadabra” at this point – simply skip it until a later point in time. 

If the menu was created from a PhotoShop .psd source file, you can 
modify the .psd file and import is as a (new) menu again. 

The original and modified menus share the same menu folder (as they 
have the same name) created by BDSL. To update the BDSL menu, take 
the following steps: 

1. change the contents of the .psd file of the menu. Existing layers 
keep their name. 

2. import it as a new menu: this creates a “menuname 1” menu 
and creates new .png files in the menu folder for all new layers 
created and replaces the existing .png files if their layers were 
modified. Layers you deleted still remain present as .png files in 
the menu folder. You may choose to delete them manually or 
simply leave them there as they do no harm. 

3. delete the “menuname 1” menu again. The .png files created 
are not deleted – they remain in the menu folder 

4. open the original “menuname” menu in the Project View and 
Designer View. The menu now shows the updated version of 
itself. 

5. In the “Objects View” and “Designer View” you may need to add 
additional (reused) buttons to new menu text selection options. 
The properties of the new objects must also be modified: what 
.png file to (re)use. For example for newly added buttons: in the 
new button object properties change its name tag “picture” into 
“button” and then load the individual button layers for the 
button states) 

Step 1: Get organized 
This step is mostly identical to the steps specified in section “Step 1 
Create new project” of the previous chapter.  

To differentiate different projects in this tutorial, we copy the D:\MovieBD1 
folder and subfolders to a new top level folder D:\MovieBD2 and open the 
project.bdmd file. This project file must be updated as it requires that all movie 
properties point to this new folder rather than the original. 

However, you may simply add to the current \MovieBD1 project if you 
like. 

Now that we are introducing menus into the project, the project folder 
needs to be enhanced by adding a new folder \imported_sources for the 
menu sources such as PhotoShop layered files or set of .png files. 
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Step 2: Include the movies 
This step is identical to the steps described in section “Step 2 Include the 
movies” of the previous chapter. It may be postponed till after the menu 
has been defined and its navigation specified and checked during 
simulation. 

The files need to be demuxed into audio and video streams that are 
compliant with the bluray specifications. Chapters are added. The Movie 
placeholders properties must be filled in with actual movie files. 

In addition one menu background movie must be specified. If you have 
multiple menus, the same menu movie can be used. Switching between 
menus then will let the background movie continue to play. Here our 
silent black movie is called “black HD video 20s” that runs for 20 seconds 
(but BDSL repeats is endlessly in a loop). 

Step 3: Create the menus 
Rather than starting the movie directly, in this project we add a menu 
that opens when the disc starts. From the menu we then select which 
movie to play. 

We need to provide a menu structure to show the viewer of the disc 
which allows him to make a selection of what movie to play. Because 
movies and menus are independent structures, you may start creating 
the menus and their navigation first, using the movies only for their 
movie-entry placeholders. 

This project uses a very basic menu: just a screen showing the available 
titles and allowing to select any one of those for playback. Once playing, 
the remote control buttons are used to change audio, subtitles and jump 
from chapter to chapter the same way as was done in the earlier project.  

Create a static background 
The opening menu screen is a still image showing the titles of the 
movies. This menu must be created outside BDSL. It can be a .png file or 
a PhotoShop .psd file. In both cases BDSL will import them and store the 
menu in a menu specific folder. All buttons are also stored as .png file 
for each of their states. 

Our simple project uses a single menu screen that lists the two movies 
with their titles and a button next to each title so you can select the 
movie and activate it (play it). 

There are two ways to make a menu: 
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 full screen 1080x1920 pixel image with text and buttons 

 several small parts. Each part only has the text or image to 
show. The rest of the menu is filled by the background menu 
movie 

If it is a simple disc with a single (or maximum 3) menus, the full screen 
menu image can be used. If you have more menus, the second option of 
small parts must be used. The total pixel count of all menus must remain 
below 7 900 000 pixels. 

We will show you both approaches. In this project we’ll use the full sized 
menu. In the next project, where we will add a setup-menu. this setup 
menu will be composed of smaller parts. 

Full sized menu 
This method only works if a single menu (or maximum 3) are needed in 
the project. 

Use any image editor to create a full sized (1080x1920 pixels) 
background image consisting of pictures and text. Buttons will come 
later in either different layers or as set of additional .png files. 

In our project we use a layered .psd file with the background as a single 
bottom layer.  

 

By default, PhotoShop names the background the “Background” layer. If 
you want to specify a different name, copy the background in a separate 
layer with its own name (and delete the background). Any layer not 
conforming to the naming convention for buttons is automatically 
becoming a flat picture image within BDSL. The .psd file is stored in the 
BDSL project directory folder  D:\MovieBD1\MainMenu.psd . 

If you do not use PhotoShop you create the background directly as 
separate .png image. Any name will do – BDSL will create its own .png 
file in a specific project menu folder it creates. 
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The background image is complete: all menu text is included, the 
buttons will follow later. 

Creating buttons 
Buttons are selectable locations on the menu. We will create them with 
two states: “Normal” (which is always visible unless transparent) and 
“Selected”. 

The two buttons we will add to the movie titles on the menu need to be 
added to the menu .psd file. Each button will have two states: normal 
and selected. This means that each button has 2 layers. In total we have 
2 x 2 buttons and therefore 4 layers apart from the background layer. 

For the “Selected” state of each button we create a yellow circle with a 
transparent (black since the background is mostly black) arrow. The 
“Normal” state is the outline of a grey circle. 

Note: if the normal state is completely invisible (a blank layer) in PhotoShop, it 
is not imported into BDSL and it will look like there is no normal state. When 
you try to perform a “simulation” BDSL will tell you there is no “Normal” state 
image. The solution is to open the .png file of “S” state that is made by BDSL in 
the menu folder, to copy it under the same name but with “N” rather than “S”. 
Open that file, select the entire “S” image and delete it (make it transparent). 
Then save the file with its transparent content. 

The yellow circle for the “Selected” state is in fact a text character from 
the “Wingdings” font (glyph number 0xDC, in normal text fonts it is 

usually “Ü”):  where the black circle is coloured yellow by taking a 
yellow font colour. The font size is increased to fit the text of the menu 
background. 

Of course for any project you can make the image as elaborate as you 
wish: small part of a photo, a home-made icon, anything. But here we 
keep it simple: a simple Wingdings character. 

In PhotoShop a new text layer is created and only this one character is 
typed. The layer is stored under the name btn:Button:S . 

The grey outline circle is another character from the Wingdings font 

(glyph 0xA1, usually “i” in normal text fonts):  where the font colour is 
choosen to be greyish. This layer is stored as btn:Button:N . 

This way we have the two states of the button represented as two layers 
in the PhotoShop .psd file. When the .psd is imported as a menu, BDSL 
will show the menu background and a single button with two states. 

Within BDSL we can copy the button multiple times (reuse! the pixels 
only count once against the maximum of 7 900 000!). Each copy will get 
its own name and in its properties it will be connected to the specific 
movie or menu it can activate. 
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The final PhotoShop file with menu image and button layers is saved in 
the project folder under the new subfolder \imported_sources under 
the name MainMenu.psd. 

 

 

 

The figure above shows the two states of the button and the three 
layers in the PhotoShop file.  
 
Each layer can also be created separately as 3 .png files (1 background + 
2 button states). In this case the files are very small, completely 
transparent (checkered background) except for the circle images. Both 
states are shown below as separate images as Button_s.png (arrow) and 
Button_n.png (circle) respectively. 
 

      

 
Although the two states of a button will overlap each other in the final 
disc production, they are shown here next to each other. Within the 
BDSL Designer View we can individually move those states until they 
overlap and “make” the one button. 
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Importing menu and button files as .psd PhotoShop file 
The menu becomes part of the BDSL project when it is imported into 

  
 
the project. For this, the .psd file is imported using the Project Tree 
window of BDSL and right-click on the “menus” branch and select 
“Import plain PSD”. Navigate to the stored 
\imported_sources\MainMenu.psd file and start the import. 
Once you selected your image file, BDSL wants to know what sort of file 
it is and how it should be interpreted. So it shows the next window. 
 

 

For plain PhotoShop file leave the default choice of “Blu-Disc Studio 
(plain) format” enabled. If the menu was created using Scenarist or 
DoStudio software, you select those. 

If your image file also contains empty layers (e.g. there is no image for 
the “Normal” state of buttons) do not check the “skip empty layers”. 

Importing menu and button files as separate .png files 
If menu and button states are made as separate .png files, the import 
process is slightly different from importing a PhotoShop file. It requires 
using the “Library View” window of BDSL. This window is opened 
through View > Library or by pressing F6. This view is BDSL’s version of 
the Windows File Explorer.  

Once open, you navigate to the \MovieBD2\imported_sources folder 
where you saved the individual source files for menu and button states. 

All .png files must adhere to a strict naming convention specified in the 
earlier section “Menu and buttons as separate flat image files” on page 
44. 
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To import these files into BDSL you need to drag the set of files for all 
states of a single button from the Library window onto the Designer 
window. The process is repeated for each button.  

You select those files by selecting each of them individually through 
mouse clicks while keeping the CTRL key pressed 

The Designer window is opened via View > Designer (F2). To create a 
button for a particular menu, first select the menu from the Project Tree 
window. This synchronizes the Designer window for that menu. 
Whatever is already part of that menu is shown on the Designer 
window. 

Now drag all files that make up one button from the Library view onto 
the Designer window. BDSL recognizes files that together make a button 
by asking: 

 

Confirming with “Yes” will create the button. Saying “No” will not import 
the files and not create a button. 

Any file dragged onto the Designer window that is not part of a button 
automatically becomes part of the static (background) image.  

BDSL Menu files 
BDSL will then create the \MainMenu folder in the project directory and 
store the resulting .png files created from the imported files. 

 

 
 

From this moment on, the menu in BDSL is built from these \MainMenu 
files. Any change made to these files directly immediately is reflected in 
the menu in BDSL. 

Within the BDSL project, all elements that are part of a menu are shown 
in a separate window of the BDSL project: the “Objects” view. This is 
opened through View > Objects or by pressing F4. Currently there is one 
menu composed of one background image (P) and one button with two 
implemented states (N and S). 



Blu Disc Studio Lite – A Beginner’s Guide   53 
 

 
 
The menu bar has a set of “state visibility” icons. These allow you to 
specify which states are shown on the Designer View but also which 
ones are highlighted on the Objects View.  

 

The icons with blue background state visibility for the Normal, Selected, 
Activated, Current state respectively. By default only the Normal state is 
shown. For our current project with buttons with Normal and Selected 
states, it is useful to enable/make visible the Normal and Selected states 
(purple and red button). 

The names of image and button are the same as those given to the 
individual .png files or the PhotoShop layers. 

There is a 1-to-1 correspondence between the .png files stored in the 
menu folder created by BDSL and the objects shown in the Objects 
window. 

Buttons in Designer View 
The Designer window is opened via View > Designer (F2). The buttons 
shown on the Designer View can be manipulated: 

 states of the same button can be positioned on top of each 
other 

 the position of a button can be changed to align with the menu 
text it belongs to 

 a button can be duplicated 

Only the buttons and their states are shown that are set visible through 
the “state visibility” icons on the menu bar as mentioned in the previous 
section. 

 

Like movies, buttons also have properties. These will specify what 
happens when a button is selected or activated. One property is 
important: the name of the button must be unique. BDSL will give them 
unique names as “Button”, “Button1” etc but these are less than 



54  Blu Disc Studio Lite - A beginner’s Guide 
 

informative. The first thing to do once a menu has all its buttons 
positioned correctly, is give each button a descriptive name. 

Buttons and background images are also ordered much in the same way 
Photoshop layers have a particular order and can hide lower lying 
elements.  

The top most button is the one that is initially in its selected state when 
a menu is displayed on screen.   

The buttons at the top of the list may occlude lower listed buttons. For 
this reason, static pictures of the menu background should be at the 
bottom of the list. Any position higher up the list may hide some of the 
buttons. 

Copying buttons 
In our current menu there is but a single button defined although there 
are two movie titles listed. Each title should have its own button. 

Fortunately, this is easy to do through the Designer View window. The 
Designer window is opened via View > Designer (F2). The “Normal” and 
“Selected” states are set visible. 

Buttons are fixed in their position until you allow them to be moved: 

 move all states of the button at the same time by “unlocking” 
the fixed position of the button by clicking on the menu bar icon 

 so the lock opens  . You can now move each button to the 
position you want. All state images remain in their respective 
positions. 

 move state images individually. This first of all requires that the 
button can be moved at all (see previous) but in addition you 
must be able to move state images separately in order to place 
them on top of each other to make the “one button”. This is 

achieved by clicking the icon   such that it becomes  

Initially we have the one button with 2 states.  

 

By unlocking the states we can position both state images on top of each 
other: 
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This still is a single button. We need a second one for the “Crosscut” 
movie. For this: 

 we “lock” the states again  

 Right-click on the yellow button and on the opening popup 
window specify “Copy To” and select the menu to where the 
button must be copied to. We only got one menu, so we select 
that.  

    

 The copy is positioned on top of the original. Therefore, use the 
mouse to select the copy and drag it to its new position 

    

 Repeat the last two steps for as many copies as we need of the 
button 

 Click on each button in the Designer View and open the 
properties View of that button and give it a proper name. 
(Alternatively: click on a button in the Objects View and the 
properties of that button will be shown). 

      

The new names of “Button 1” and “Button” now reflect the movie the 
button is positioned to (“Crosscut” and “Space Race” respectively). 

Adding buttons later 
In some cases you will create a new project but would like to reuse some 
of the button images from an earlier project.  

In this case, you create the background parts of the image by importing 
the PhotoShop file or separate .png images. 
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Look in the “Objects” view of the menu once it is imported into BDSL. It 
will only show “P”-type picture elements as menu backgrounds.  

 Click on the “Add object” button ( ).  

 The object view now shows a new “Item1” under “name” and 
assigns it a “picture” property 

 Change the “picture”  into “button” by selecting another value in 
the dropdown box. 

 
 Ensure all states of a button are shown in the object view by 

enabling these states by clicking on the “state visibility” icons 

 
 Select each state of the button in turn and assign what .png 

image should be assigned to that state. 

 
 You have now completed all properties of the button 

If multiple copies of the same button are required, you can copy them 
(select, copy, paste) on the menu as described in the previous section 
“Copying buttons” on page 54.  

Once done, you need to rename them to a sensible name. After that 
each button is assigned additional properties (what action to take when 
selected, how to navigate to other buttons etc) as will be described in 
the sections below. 

Sorting and aligning buttons and images 
Looking at the button order in the Objects View shows that the Crosscut 
button is the top most one and therefore the one shown as selected by 
default when the menu opens. This is not what we want. We must re-
arrange the button order. 

You do this by: 

 open the Objects View 

 select a button (any visible state will do) 

 move its position up or down using the positioning icons on the 
project menu bar  
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where icons indicate “move to the top”, “one position upwards”, 
“one position downwards” and “move to the bottom” 
respectively. 

 Repeat these steps for all buttons until the order is as desired. 
Ensure that all buttons are in a higher position than the static 
backgrounds. 

The initially incorrect order shown below 

    

is set straight after rearranging the buttons. 

 

You can further align buttons with their left/right sides, top/bottom 
sides by selecting these buttons in the Objects View and via right-click 
select the “Align” menu choice. 

Button navigation and button actions 
Now that all buttons are in place, the navigation needs to be completed 
by filling in the properties of each button. This requires the “Properties” 
window to be open (View > Properties (F11)). 

The important settings are: 

 what to do when an up / down / left / right button is pressed on 
the remote control. What button will then get selected? 

 what to do when the “OK” or “Enter” button is pressed? 
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To specify this follow these steps for each button’s properties: 

1. Select “Press Left”. When the next button is only up or down, 
leave this empty. Otherwise use the “>” button at the far right to 
specify what other menu or button to go to. 

2. Select “Press Right” and repeat the previous considerations 
3. Press “Up”. When there is a button above the selected button, 

indicate it. If there is no button you may want to roll on to the 
bottom one. Or you may want to do nothing since you’re already 
on the top. Use the “>” button at the far right to indicate what 
to do. 

4. Select “Press Down” and repeat the previous considerations. 
5. Select “Press Enter” and indicate what to do when this button is 

activated: start a new menu, start a movie.  

 

For the two movies with their buttons, the top button (next to Space 
Race) is set to respond only to 

 Press Down moves to next button (Crosscut) 

 Press OK starts movie “SpaceRace” from chapter 1  
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The second button only responds to: 

 Press Up moves to the previous button (Space Race) 

 Press OK starts movie “Crosscut” from chapter 1 

 

Navigation checks 

A new feature added in V1.0.9.50 is the new menu button ( ) 

to allow you to show the navigation you specified in the properties 
windows for the various buttons. Clicking on the button allows you to 
select what navigation to show. 

 

The menu button is in the same block as the locking of button states. It 
only shows navigation between normal states, selected states, 
depending on your choice specified in the menu. 

Showing the normal button navigation on the project we created shows 
the links indicated as in the illustration below. 
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The colours of the arrows can be set using the menu option Tools > 
Options.  

 

Menu start 
When the bluray disc starts it shows one item first. We must specify 
what item this is. 

The Project Tree window (View > Project Tree (F3)) has a “First Play” 
item at the bottom of the window. Here we specify it must start with the 
MainMenu and select the Default button. On first opening this is the top 
most button. Hence the importance of proper objects sorting. 
Alternatively, you can specify explicitly which button you want to select. 

. 

 

Movie action 
Once a movie plays, you need to specify what will happen once it is 
finished. This is specified in the “End Action” property of the movie. 

A movie can also be interrupted using the “popup menu” on the remote 
control. You also need to specify what happens then. Without popup 
menus, we currently jump back to the main menu too.  

Selecting the menu’s “default” will select the same button as was 
selected when the menu was shown earlier. You can steer navigation 
here. When a movie ends, the End Action may specify that the menu is 
shown again but with the next movie on the list as selected item. 
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Note: the Lite edition does not allow for a menu where you can both select a 
single movie to be played and afterwards return to the menu as well as a “play 
all” option. It’s either one or the other. The paid versions like BDS Standard 
allows this as it requires the use of playlists that is not part of the Lite version. 

Action Matrix 
The actions specified for all buttons are also conveniently shown in the 

Action Matrix window (View > Action Matrix (F8) or by menu icon ) 
and rather than using the properties window you can define the actions 
directly into the Action Matrix too. The contents of the Action Matrix 
window changes with what is selected in the Project Tree window. 

Step 4 Check the project 

Menu structure 
The whole set of navigational and action instructions specified are 
shown graphically in the “Structure” window (View > Structure (F7)), 

 

 

It shows with a red arrow how the disc starts playing (with a menu) and 
how from a menu one can perform an action (black arrow) to play a 
movie and what happens at the end of the movie (blue arrow back to 
menu). This menu structure visually represents the navigation 
implemented. It can quickly indicate if there are orphan elements that 
are present but can never be reached or whether there are dead-end 
alleys in which you can get but never can get out of. 
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With many movies or menus this structure overview quickly becomes 
less useful as action lines seem to merge together. The ultimate test is to 
perform a navigation simulation 

Simulation 
Simulation only checks the navigational elements of the project. You can 
exercise these thoroughly to ensure all menus are linked together, each 
button can be reached.  

The menu has a special “Play” button  to simulate the working of the 
menu navigation you specified. (Simulation (Test Menu) (F9)). 

Before simulation starts, BDSL first compiles the project to ensure all 
elements are present and connected. Where a movie placeholder 
property has no “End Action” or “Popup Menu” action defined, this is 
logged and you can take action to correct this first before starting a new 
simulation. 

The result of the simulation is shown in a separate window. In the 
default project view this window is part of the project view (in the right 
bottom corner). 

 

 

If an error occurs stating “Image buffer overflow in profile 1”, change the 
project properties to use profile 2 (menu Project > Project Properties > 
General tab, “BD-J profile version” set to 2). 
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 You use the keyboard arrows to move between buttons and use the 
<enter> key to simulate pressing the OK on the remote control. If this OK 
jumps to another menu, this menu will show. Upon return to the earlier 
menu you can check whether the specified button or the “default” (=last 
OK-ed) button is selected. 

Only when the “OK” button is pressed to activate a movie, the movie is 
not shown. Instead, a black window is opened where the movie should 
be. This “movie” can be stopped by pressing F5 after which you return to 
the menu. 

The simulation stops when the simulation window with the shown menu 
is closed. Any navigational errors you found (wrong links between 
buttons, no links, a menu is not opened etc) can be rectified. Repeat 
simulations until you’re satisfied the entire navigational structure is 
correct. 

 

Step 5 Create the project 
This step is identical again to the step described in the previous chapter 
(see “Step 4 Build the disc” on page 28). 

The progress of the muxing and final result of the building is shown in a 
separate window shown below. When you use the default project view 
this window is part of the project view and is located in the bottom 
righthand corner. 
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This window must be closed once the build process completed before 
you can do anything else.  

The bluray compliant file structure is written in the folder indicated in 
the Project Properties: 

 

with the actual video movies stored in the STREAM folder – just as large 
as their original source input (before they were demuxed). 
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Step 6 Test run the disc 
This step again is identical to the one described in the previous chapter 
(section Step 5 Test running the disc on page 32). 

If you don’t see the background video displayed properly, check that is 
does have 1920x1080 pixels. Any other may result in improper 
backgrounds that may show only part of the video or none at all. 

Step 7 Burning the disc  
This step is identical to the one described in the previous chapter 
(section Step 6 Burn the bluray disc on page 34) 
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Additional possibilities while creating a simple bluray disc 
This chapter simply provides some additional features you can use while 
making a simple bluray with menus. Features that may limit the tedious 
amount of work while connecting all the elements of a menu. 

Creating an intro movie 
Officially you cannot make an introduction movie that is played when 
the disc is started. 

But you can make a sort-of introduction: 

1. Add a movie object to the Project Tree 
2. Provide the audio and video track information 
3. Set the “First play” of the Project Tree to play this intro movie. 
4. In the intro movie property specify “End Action” (as well as “Pop 

up menu”) and indicate the real main menu to show when the 
intro finishes (and specify which item to select by default). 

Running the disc now will start the intro movie and jump on to the main 
menu.  

Please note that you ought to add this intro as one of the last things you 
do on the disc. Because it is the “First Play” setting, it will “run” when 
the simulation mode is used. Simulation does not play back movies and 
you get “stuck” with a black screen during simulation. Stop the 
simulation (close window or press F5), set “First Play” to your main 
menu and simulate again. Only when satisfied with all, modify the “First 
Play” back to the intro movie (and ensure it points to the main menu 
once its run completes). 

Action: Where to go next 
All movies mentioned must revert back to the menu they are listed on 
when the movie is interrupted or ends: 

 if interrupted by pressing the “popup menu” button (sometimes 
called “Title”) on the remote, return to the main menu (specified 
in the “Popup Menu” property) and highlight the button that 
starts the movie 

 If completed, the “End Action” can specify the same menu but 
go to next movie button on the list. 

Navigation between buttons 
When buttons are aligned in a row or column, often you want the “up” 
and “down” navigation to be performed to the adjacent button. Rather 
than specifying this all manually in the property items of each button, 

you can automate this process using the “auto assign” button ( ) in 
the menu. 

First open the Object View and select all buttons that take part in this 
automated navigation assignment. Then click on the menu button “auto 
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assign” which gives you two options: “auto assign between buttons” and 
“auto assign between music”.  Select the “auto assign between buttons” 
option. This opens the next window in which you can specify how the 
navigation must take place: top down, bottom up, left right, right left or 
diagonal. 

 

After the selection and pressing OK, the “Press UP” and “Press DOWN” 
(or “Press Left” and “Press Right”) properties of the buttons is 
automatically filled. 

You can check on the result by inspecting the links created using the 

“Show navigation links” button ( ) on the menu bar. 

Copying properties between movies 
Any film clip to show, must be a “movie” entry in the Project Tree view. 
When you insert multiple movies you need to set all their properties. 
Again, if some properties are the same between movies, BDSL helps you 
by copying information.  

Select a movie with the appropriate settings, right click on it in the 
Project Tree window to show its popup menu. 
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“Copy properties to all” is useful to copy the same properties to all other 
movie entries regardless overwriting whatever is specified (including any 
specified movie, audio and subtitle tracks). 

“Copy properties to all empty” is more subtle:  it fills only the empty 
properties of the movies, leaving any set property (such as what movie 
to play) alone. 

Changing background image of a menu 
Since the background image is based on a .png file that BDSL created in 
its own menu specific folder, any modification of the background to 
reflect in the project must be made to this created file. 

The file name is mentioned in the Object view for the background 
properties. 

 

Modify the file to your liking and BDSL will use the new version from 
here on.  

Alternatively, you may modify your own source file and re-import it into 
BDSL as a new menu. However, many of the menu parts as well as the 
BDSL menu folder name are the same. The import by BDSL ensures that 
many of the newly created .png files replace the old ones. Therefore the 
changes in the menu are seen on the original menu as well as the newly 
created menu. Simply delete the new menu and all modifications made 
in your own .psd file or set of .png files show up in the original BDSL 
menu. This is what is referred to on page 45 in section “Quick 
corrections once you get the hang of BDSL”. 
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Project 3: Creating a bluray disc with setup menu for audio and subtitles 
The project goal 

We expand the created second project by adding a new menu item on 
the main menu, called “Setup” that will open up a new menu to show 
the languages that can be selected as audio and/or subtitle. This Setup 
menu is a new, second menu. It will be made of individual parts rather 
than being a full screen image. This way fewer pixels are used (only a 
total of 7 900 000 is allowed for all menus together). This approach 
works for all menus of course. But if you have fewer than 3 menus you 
can use 3 full screen menu backgrounds without running into trouble. 

The setup menu also uses the “Current” state of the buttons to show 
what the current setting for audio and subtitles is. This project extends 
the previous one by: 

1. adding a second menu that is referred to from the main menu 
and that can return to the main menu 

2. using button “Current” state as well as “Normal” and “Selected” 
3. building the menu of parts rather than full screen 

What you need to know about Movie groups first 
You may have noticed that adding a new movie placeholder to the 
project automatically creates a new group in which the movie is added. 
If a check is set on the “Autorename” box the generic “Group XX” name 
is automatically changed into the movie name. Effectively, each movie 
will be in its own group. 

 

What’s the point of a group? The settings for audio and subtitles are the 
same for all movies that share a group. This makes it easy to have a 
setup menu for the movie group to select the audio and subtitle streams 
to use and apply that choice to all movies in the group. 

Since the setup specifies what track number to use, you must ensure 
that all movies have the all tracks sorted identically. For example, all 
movies with 2 audio tracks have audio track 1 for English dialogue and 
track 2 for the Dutch dubbing. If you set audio to track 2 it is that track 
that is played regardless. That should be the Dutch track, but if by 
mistake one movie has a French track as audio 2, the viewer will hear 
French despite of the setup for “Dutch” (in fact for track 2). The property 
indications “eng” and “nld” for both languages are used to be displayed 
on screen when audio is selected by the remote control audio select 
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button. It is not used internally bu BDSL. The program uses the track 
number. 

Movies can be joined to a group by changing the “Group” property of 
the movie placeholder accordingly. This can be done by using the 
dropdown list icon “V” in the “Group” property and select one of the 
already existing groups. If a new name is wanted, double click on the 
“rename” button and rename the group name shown on the Group 
property line. A single click on “rename” does nothing. 

Note: to rename a group name, double click the “rename” text at the end of 
the “Group” property value. There is no special “group” item in BDSL. The 
group names are entered as text value in the movie property. A new string 
value indicates a new group. 

 

Step 1: Get organized 
This step is mostly identical to the steps specified in section “Step 1 
Create new project” of the first project.  

To differentiate different projects in this tutorial, we copy the D:\MovieBD2 
folder and subfolders to a new top level folder D:\MovieBD3 and open the 
project.bdmd file. This project file must be updated as it requires that all movie 
properties point to this new folder rather than the original. This is true for all 
objects and their images (like buttons and background image on menu). 

In normal situations you would simply stay in the first project and make 
changes there. There is no problem if you decide to do this yourself. 

There are no new folders to add nor movie files. We will add a new 
setup menu and button state in due course. 

Step 2: Include the movies 
This step is identical to the steps described in section “Step 2 Include the 
movies” of the first project. It may be postponed till after the two menus 
have been defined and their navigation on menu and between menus is 
specified and checked during simulation. 

We do need to move all movies into the same movie group. (If in 
another project not all movies have the same audio and subtitle tracks, 
only add the movies into one group that have the same track types). 

To do this, open each movie placeholder property window and specify a 
groupname. In this example project we use “AllMovies” as group name. 

 The name “AllMovies” does not yet exist. Therefore, open one movie 
(e.g. SpaceRace) and double click on “Rename” on its Group property 
and change the current group name into “AllMovies”. 
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The remaining movies must also be added to this group but the new 
name is now listed in their dropdown list of the group and easily 
selected. 

 

All movies are now part of the “AllMovies” group and setting audio and 
subtitles for this group sets them for all those movies. 

Step 3: Add/Insert setup menu 

Create Setup menu as set of background elements 
Rather than using the remote control buttons to select audio and 
subtitle track, we implement it as separate menu. The remote control 
can still be used for this purpose if so desired. 

The menu will consist of a static image and the text: 

 Audio 
o English 
o Nederlands 

 Subtitles / Ondertitels 
o English 
o Nederlands 
o None / Geen 

 Main Menu 

The text lines will get buttons to set the preference and the Main Menu 
item is needed to return to the main menu to select the movie to play. 

The text block can be made of individual pieces or as one .png file or 
PhotoShop layer. The image will be a separate layer. We will reuse the 
button from the Main Menu so it will be copied into the menu later. 
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Here we will use a PhotoShop file with two layers: one of the image and 
one for the text. The size of the image is set to 1080x1920 pixels so we 
know the boundaries within which our elements must fit.  

You can create separate .png files for the menu and import those as elements 
of the menu. This will be explained shortly. 

The final setup menu may look like the picture below. The two layers 
(red text and picture) are visible on a transparent (checkered) 
background. This background will be provided by the menu movie. Since 
this is choosen to be entirely black and silent, the menu will appear to 
have a black background. 

 

You need not worry about proper positioning yet. Once made part of 
BDSL you can use the Designer View window to move objects around to 
their final location. The one thing you cannot do in BDSL is resize the 
objects. You need to use the right size in your menu design, but need 
not worry about the final positioning. 

The setup menu file is stored in the D:\MovieBD3\imported_sources 
folder als SetupMenu.psd. 

Import Setup menu into project as psd file 
The Setup menu becomes the second menu in the project. It is added by 
opening the Project Tree and right-click on the “Menus” branch. From 
the dropdown menu, select the “Import plain PSD file” and navigate to 
the SetupMenu.psd file. 

After import, the Project Tree view shows two menus. Ppen the 
“Objects”, “Properties” and Designer views also. 

Importing Setup menu into project using .png files 
Each layer can be created using an image editor that can output .png 
files and allow those files to have transparent parts. 

When each file looks similar to a layer in PhotoShop, you perform the 
following steps: 



Blu Disc Studio Lite – A Beginner’s Guide   73 
 

1. Right click on the “Menus” branch of the Project View Window 
2. From the dropdown menu select “New Menu” and provide it 

with the name “SetupMenu”. This creates a blank menu without 
objects. 

3. Open the Objects View. Select “SetupMenu” on the Project 
View. This will synchronize the Objects View for the menu. There 
are no objects yet 

4. On the Objects View, click on “Add” (icon ). This creates an 
object named “Item X”.  

5. Open the properties View. Select “Item X” on the menu objects 
view.  

6. Rename the name of “Item X” to something meaningful (such as 
“menu text” if we’re going to open the menu text file) 

7. Click on the property “Image” . This opens a file navigation 
window. Navigate to your source file (for example the file 
containing the menu text) and open it.  The Setup menu now has 
its first object. 

8. Repeat steps 4 to 7 for each new object on the menu. In our 
example setup there are only 2 objects: image and menu text. 

If you want to add buttons as objects, use the same procedure as in the 
previous project (drag button state files from Library view onto Designer 
View and go from there). 

Customizing the setup menu 
Clicking on the “SetupMenu” of the Project Tree view synchronises the 
other windows to show their information on the SetupMenu. 

 

 

It shows in the Designer View the two layers against the gray 
background (to be filled by the menu movie). It has two objects, one 
called “picture layer” and one “menu text layer” (the names of the two 
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PhotoShop layers or of the individual .png files). When the “picture 
layer” is selected as object, this is highlighted on the Designer View by a 
yellow hatched box provided the “Show Selection” button on the menu 

bar is enabled ( ). 

Notice that according to the property information shown above, the 
picture only takes a rectangle of pixels (1080 high and 867 wide) instead 
of full screen 1920. The curved left side is fitted within the narrowest 
rectangle possible. The transparent pixels shown as grey background 
within the rectangle do count as pixels for the maximum total pixel 
count of 7 900 000. 

Selecting the menu text layer object surrounds the menu text with the 
yellow hatched box that is sized 548x618 pixels. 

 

 

Rather than selecting any object in the Objects View, you can also select 
an object directly in Designer View. That will automatically synchronize 
the other windows (objects, properties) with the selected object. 

Using the Designer View you can move around the individual objects to 
their final location. Note that this only works when you unlock the 

objects by setting the icon  to the state  by clicking on it in the 
menu bar. 

You cannot resize the objects nor change them (adding or removing 
text). This needs to be done in the original source files or the .png files 
created by BDSL.  

The import of the new menu objects resulted in BDSL creating a new 
folder in the project folder, containing its own .png files made from the 
Photoshop .psd or your own .png files. 
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Any change made directly to these files will show on the BDSL project. 
Any changes made to your own files do not – unless imported again. 

All that remains to be done is to assign a menu movie to the SetupMenu. 
Take same same one as used for the MainMenu. This way switching 
between menus will not interrupt or restart the menu movie but let it 
continue. 

Updating the MainMenu with extra list option 
Although we can move from the SetupMenu to the MainMenu (once the 
buttons are in place), the MainMenu has no option for the Setup Menu. 
There are two ways of accomplishing this: 

1. Modify the sources, import them again as a new menu and 
delete the new menu.  

2. Edit the .png files made by BDSL in the specific menu folder 

The second option seems the easiest one for those using separate .png 
files. Here we will modify the original MainMenu.psd file and re-import 
it as option 1 suggests. 

The only change to be made is in the background layer of the 
MainMenu: add a line with “Setup”.  

It may become a separate text layer, but we’ll merge it with the rest of the 
image – saves pixels as otherwise the total 1080x1920 pixel image of the 
background layer would be increased by an extra text layer. 

 

Then the following steps are taken: 

1. Save the MainMenu file, overwriting the old one without the 
Setup line. 

2. Use the BDSL Project Tree view to import this MainMenu.psd file 
as we did before. This will create a new menu item “MainMenu 
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1”. This menu will have the new “Setup” line as well as the one 
button in two states.  

3. The original MainMenu also has the same background as 
MainMenu 1 since the same set of .png files are used since the 
new imported menu shares the same “MainMenu” menu folder 
of BDSL since the imported file has the same name as the 
original main menu. The original MainMenu has two buttons 
however and their states overlap – just as they were made in the 
previous project. 

4. Delete the new “MainMenu 1” menu. The .png files BDSL 
created or replaced in step 2 remain. 

We only need to “patch up” the main menu by providing an extra button 
to place in front of the “Setup” text and fill in the properties of the 
button: 

1. Copy the Crosscut button and paste is copy into the MainMenu. 
Rename it from “Crosscut 1” into “Setup”  (see section Copying 
buttons in page 54) 

2. Ensure from the Objects View of the MainMenu that the Setup 
button is the last button on the list (each new button is by 
default placed on top). 

3. During navigation from the Setup button the Press UP action 
must point to the “Crosscut” button (at the same time, the 
“Crosscut” button must be modified that it has a Press DOWN 
propery that now points to the Setup button) 

4. The Press ENTER property of the Setup button jumps to the 
SetupMenu. 

 

 

Adding button state “Current” to prototype-button 
The Setup menu is now part of the project but has no buttons – just 
background elements. 

The one button that does exist, has two states, and in the \MainMenu 
folder of BDSL each state is represented by one file. Either 
btnButtonS.png (Selected state) or btnButtonN.png (Normal state). 
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We need a “Current” state for the buttons on the Setup menu. For 
simplicity we want it to look like the Selected state but in red colour 
rather than yellow.  

The easiest way to do this is to open the btnButtonS.png file in the 
MainMenu with an image editor and recolour it red and then save if 
under a new name: btnButtonC.png. This name is required by the 
naming conventions of BDSL. 

We save the new state file in the \MainMenu folder as this keeps all 
button state files in one location. Any other location is fine: as long as 
the property of the button state refers to the correct file. 

The end result will have the content of the btnButtonC.png file as shown 
below. 

 

In PhotoShop you may use the “eyedropper” to select the yellow colour and 
then fill the selection with a red colour. 

Copying buttons from MainMenu to Setup Menu 
We will copy the same button from the MainMenu to the SetupMenu 
going through the following steps: 

1. Open the Designer View for the MainMenu 
2. Select a button, for example the one in front of “Space Race” 
3. Right-click and specify Copy To: menu:SetupMenu 
4. Select SetupMenu on the Project View. This will also show the 

SetupMenu on the Designer View 

5. Ensure objects on the menu are not locked (menu icon  

unlocks objects and  unlocks states of a button) 
6. Move the button to the location of the “Main Menu” text 
7. Copy the button repeatedly and move the copy to the text lines 

for subtitles “None”, “Nederlands”, “English” and for audio 
“Nederlands” and “English”.  
(By working from bottom to top the new button copies are 
already in the right order in the SetupMenu objects list) 

8. A total of six buttons must be on the SetupMenu by now. 
Rename all button copies (currently named after their “father” 
on the main menu) to proper names indicating the choice of the 
menu they stand for 

9. Check if audio/English is indeed the top object and that all 
picture objects are at the bottom of the list. If not, rearrange the 
buttons in the object view until they are in the proper order 

10. Align all buttons by selecting them together in the Object view 
and with a Right-click select “Align” > Left 
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11. Enable the visibility of the “Current” state (click on green circle 
on menu bar). This will now show the green © icons in the 
object view. But no image is yet connected to this state. (In the 
following steps if you get confused about button images and 

their state, use the “make visible” icons  that can either 
show or not show those states. Handy if the images overlap and 
one is behind the other!) 

12. Select the first button with the © state. (In our project it was 
renamed to “UKAudio” as the first menu option for English 
audio). Its property “Current” (the state name) has no image. 
Click on the “…” at the end of the line and navigate to the 
btnButtonC.png file and select/open this.  

 

13. Now the button has a visible Current state represented by the 
image in the btnButtonC.png file 

 

14. From the Top/Left positioning information you can see this 
image does not coincide with the other images for the button. 
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You need to rectify this. Look up the proper values for Top/Left 
for the button by looking for the values specified for the “S” 
state. Copy those values for Top/Left for your “C” state. 

15. Repeat step 12-14 for all button C states in the SetupMenu. 

When all buttons have the Current state image added at the proper 
place, you should see a picture like below, where only the Current state 
images (green coloured circle on the menu bar) are made visible. 

 

Although the button is copied from the MainMenu, the buttons on the 
main menu do not have a Current state – simply because in their 
properties there is no image linked to that state. 

Provide navigation between links 
All buttons are in position on the Setup menu at this point. We need to 
specify the navigation between the buttons. 

The navigation UP and DOWN between buttons is the same as in the 
previous project.  

The action to be specified for Press ENTER is different: 

 the “Main Menu” button must jump to the MainMenu menu. 
This way we can switch between the two menus. Either it jumps 
to the “Default” in MainMenu (selecting the last selected button 
on it) or a specific button can be specified to be selected 

 The first audio button (English Audio) must specify SET AUDIO > 
group AllMovies > Track 1  (which is the English audio track) 
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Notice how automatically the “Highlight” section of the button is 
filled it: it will highlight the “Current” state if this audio choice is 
made. 

 The second audio button does the same but specifies track 2, 
the Dutch audio. The Current state will show when track 2 is set. 

 

 The subtitle tracks are handled the same way: SET SUBTITLE > 
AllMovies > Track 1  for English subtitles. Again, the Current 
state is filled in for subtitle track 1 if this button is activated 

 The button for no subtitle track uses the Press ENTER action SET 
SUBTITLE > AllMovies > -none- 

Step 4: Check the project 
This step checks if all links are present and is no different from the 
description in section “Step 4 Check the project” on page 61. 

Step 5: Run simulation 
Once the entire menu structure has been set up, the simulation will 
allow you to run through all scenarios and see if the links are set 
correctly. 

If during simulation compilations errors are detected (no menu movie, 
no End Action or Popup action specified or other omissions) you can 
correct these first and start simulation again. 

The new setup menu must be reachable from the main menu and you 
must be able to return there. 

The setup menu looks like the image below. 
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It has English audio and no subtitles as starting value – hence the red 
coloured Current state buttons. You can still move through all buttons 
which in turn will turn yellow, including the one that are currently red. 

Exiting this menu by selecting “Main Menu” retains the two red coloured 
buttons. If you change the default subtitles to “Nederlands” then that 
button will show “current”. You can move the cursor to the “Main 
Menu”, return to the main menu, select a movie and… it will show the 
Dutch subtitles because both movies belong to the AllMovies group for 
which you just selected “Nederlands” for subtitles. 

 

Step 5: Create Bluray disc 
This step is identical to section “Step 5 Create the project” on page 63. 

Step 6: Burn the Bluray disc 
This step is identical to section “Step 7 Burning the disc” on page 65. 
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Project 4: Creating a bluray disc with popup menus for chapters 
The project goal 

In previous sections you created a bluray disc with movies that had 
audio and subtitle tracks, each to be selected through a setup menu (as 
well as through the remote control buttons). 

From the first project, each movie had chapters, but jumping from 
chapter to chapter remained an action using the remote control. For 
many that will suffice.  

However when you take painstaking care to insert chapter marks at 
precise points in the movie rather than at fixed intervals, you may want 
a special menu to allow selection of that particular chapter. 

BDSL allows you to do this in three manners: 

 create a menu like the earlier Setup menu. This lists all chapters 
(like “Opening”, “The Chase” etc), possibly with a small image, 
and each item is linked to the movie chapter of that scene. The 
creation of this type of chapter menu is similar to creating the 
setup menu (without the need of “current” states for buttons) 

 create a menu with visual list of opening pictures for each 
chapter. Each picture functions as button to jump to the 
chapter. This list is created automatically by BDSL itself. 

 create a popup menu as visual list of opening pictures to show 
when a movie plays. The list is created by BDSL itself 

This chapter will use the second/third method as the first one is already 
described in the third project, adding a (setup) menu. 

Add popup menus (text) 
A popup menu is created the same way as a normal menu (through a 
.psd file or set of .png files) and it created in the Popup Menus branch of 
the Project Tree instead of the Menus branch. 

Because a popup is shown on top of a playing movie, it is normally never 
full screen, but uses only a part of the screen – such as a rectangular 
black bar. How such a smaller menu is created is described in the project 
3 where a Setup menu is created of image parts and buttons. 

From ordinary menus there is no link to the popup menus. But popup 
menus can refer to other popup menus.  

A complete illustration of making a popup menu is shown in the “10 
Minutes Quick Start to Blu Disc Studio” tutorial (YouTube and 
document). 

Add chapter menus (picture buttons) 
BDSL allows you to create a chapter menu automatically. Each starting 
image of a chapter is used as button to select and activate (meaning 
jumping to the chapter).  
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This chapter menu can be positioned on the popup menu background. 

The entire procedure is described in the “10 Minutes Quick Start to Blu 
Disc Studio”. 
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Project 5: Creating a bluray disc using extended menus and popup 
menus 
The project goal 

This final section describes the use of menus often encountered on 
commercial bluray discs. A small main-menu is shown on top of the 
background menu movie. Selecting any item of this menu shows an add-
on menu with specific choices. The “10 minutes quick guide” shows how 
an “Audio” menu item expands in the various audio options (like dts, 
stereo, commentary, music-only etc) available to the movie. 

Such menus and expansions of them can also be shown while a movie 
plays. Then they are called “pop up” menus. It depends on your remote 
control on how to make these visible. This can be the ”Title” button, 
sometimes “pop up”  or some other button. 

This project creates the disc using these menus rather than mostly full-
screen menus used in previous sections. 

The D.I.Y. project 
With all information from previous projects you should be able to 
complete this one entirely on your own. 

But some tips: 

 you may create an all dancing no talking main menu movie and 
superimpose the menu options on top. This can be a text layer 
and some buttons. The rest of the screen is filled with the menu 
movie.  

 The menu movie may have a black rectangle on top of which the 
menu items are shown. Alternatively, the menu may have a 
black image object that blocks part of the menu movie and gives 
clear room for menu options and buttons 

 The popup menu (only shown while a movie plays) should be 
mostly transparent since it is projected on top of the playing 
movie. A menu consisting of a black rectangular area in which 
the menu options and buttons are shown makes them clearly 
stand out from the playing movie.  

 Popup menus are mostly used to change audio or subtitle tracks 
to the movie or to show a chapter list from which you can move 
position in the movie. Popup menus usually disappear after a 
selection is made or when the “popup menu” button on the 
remote control is pressed again 

 An example popup-menu is given in the “10 minutes Quick Start 
Blu Disc Studio” guide – both as YouTube video as well as 
written accompanying tutorial. 
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Appendix A: Bluray specifications 
The following data indicates the Bluray Disc Association (BDA) decisions 
on capabilities bluray discs and standalone players must have. This will 
also reveal in how far Blu Disc Studio adheres to these standards. 

An interesting description of all these details is found in a book by Jim 
Taylor a.o. “Blu-ray Disc Demystified” (McGraw-Hill Publishers, 2009, 
ISBN 978-0-07-159092-1) 

America vs Most of the Rest of the World 
For Blu-ray, all players must support 23.976/24 Hz, 29.97/30 Hz and 
59.94/60 Hz progressive. 

Optionally, players in 50 Hz (25 or 50 fps) countries (such as Europe) may 
also support 24.97/25 Hz progressive. 

This means that a disc can be created for all regions (24 Hz/30 Hz) unless 
the video is specifically targeted for the 24.97/25 Hz markets. 

Note that some software players will playback 50i and 59.94i but most 
standalone bluray players only play progressive rates (incl. 50p, 
59.94p).To be on the safe side, ensure your movies are progressive 
instead of interlaced. 

HDMV versus BD-J playback 
There are two programming modes for Blu-ray — HDMV and BD-J. Blu 
Disc Studio uses BD-J.  

Generally, there tends to be fewer incompatibility issues with HDMV 
playback than with BD-J, mainly because the BD-J environment has many 
more options and is based on a wide array of specifications. With BD-J, 
the chance for misinterpretation and differences in interpretation, are 
great. At the core of BD-J is the Java Virtual Machine (JVM). Some player 
manufacturers have licensed the JVM code from Sun Microsystems. 
Others have decided to implement their own version of JVM.  

Within the BD-J specification, there are several libraries or packages that 
do virtually the same function. Some of the early players did not 
implement all libraries properly, but the manufacturers are working 
diligently with the BDA to improve testing routines to remedy these 
situations. 

One limitation within the BDS products that use BD-J for navigation 
between menus is the maximum limit for total number of pixels in all 
menus together: these must be less than 7 900 000 . 

Player Profiles 
Standalone players can handle everything up to a certain “profile level”. 

 Profile 1, version 1.0, players introduced before November 1, 
2007, 
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 Profile 1, version 1.1. players introduced after October 31, 2007, 

 Profile 2 (optional, required for BD-Live), 

 Profile 3 (optional audio-only player), 

 Profile 4 (real time recording and editing). 

Blu Disc Studio is ignorant on profiles – the video and audio streams 
must adhere to them, but all BDSL does is muxing the streams together 
regardless of profile, as long as the muxer muxes. Bluray players can 
upgrade their firmware – unlike the older DVD players. 

MPEG-2 H.264/AVC movie profiles 
MPEG-2 is a standard compression method for video and by itself 
independent of bluray discs. One if the compression modes is 
H.264/AVC. 

It recognizes several “profiles” that determine the quality of the video 
based on types of frames used, chroma (color) format etc.  

 BP basic profile, low-end, video conferencing, mobile apps. Uses 
I,P frames 

 MP main profile, HD tv broadcasts, DVB standard, uses I,P,B 
frames 

 HP high profile, HDTV DVB broadcasts, bluray storage, uses I,P,B 
frames. This profile is recommended when you transcode 
movies to use in BDSL authoring. 

The level specifies the bitrate with with the picture is shown. Levels exist 
from 1 upwards but only after 4 they become useful for HD recordings.  

level resolution 
@max framerate  

MP 
bitrate kbps 

HP 
bitrate 
kbps 

4 1280x720@68.3 
1920x1080@30.1 

Medium@4.0 
20,000 

High@4.0 
25,000 

4.1 1280x720@68.3 
1920x1080@30.1 

Medium@4.1 
50,000 

High@4.1 
62,500 

5 1920x1080@72.3 Medium@5.0 
135,000 

High@5.0 
168,750 

 

Disc capacity 
Bluray discs come as single and dual layered discs  

disc marketing 
109 (GB) 
bytes 

actual 
bytes in 
GB 

capacity 
in number 
of DVDs 

video 
typical 
play time 

video 
min-max 
play time 

BD-25 25.025 23.306 5.3 2.3 h 1.2h-37h 
BD-50 50.050 46.613 10.6 4.6 h 2.3h-74.1h 
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The size of the discs is 120 mm with inner spindle hole 15 mm and 
reflectivity 35%-70%. Data is read with 4.9 m/s on playback 

Stream data 
To show pictures, the video is encoded in bit stream rates. The table 
below indicates typical streaming rates in Mbps 

video minimum  
(Mbps) 
(poor) 

typical 
(Mbps) 

maximum 
(Mbps) 
(best) 

MPEG-4 AVC 4  16 40 
SMPTE VC-1 4 18 40 
MPEG-2 4 24 40 
    
audio    
Dolby Digital 2.0 0.064 0.192 0.640 
Dolby Digital 5.1 0.384 0.448 0.640 
Dolby Digital 7.1 0.640 1.024 4.736 
DTS 5.1 0.192 1.509 1.509 
DTS-HD 7.1 0.768 1.509 3.000 

 

Data streams from bluray disc to player are also subjected to maximum 
limits: 

ts transport stream 48 Mbps 
video stream 1080x1920 40 Mbps 
text subtitle stream 48 Mbps 
DTS-HD 24.5 Mbps 

 

Number of BDMV elements 
angles 9 
audio streams 32 
text subtitle stream 255 
pop-up menus 32 
chapters (play mark lists) 999 
playlists 2000 
playitems per playlist 999 
movie objects (.bdjo files) 1001 
JAR files to disc capacity 
fonts 255 
menu sounds (in sound.bdmv) 128 
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Appendix B: Things to remember 
BSDL assumes certain things that may cause you to raise your eye 
browse. Here is a list of things you need to remember. See also section 
“Possible problems – including “line:0” errors“ on page 31. 

 maximum menu pixel size is 7 900 000 pixels. Regardless the 
number of menus or buttons used, their total size may not 
exceed 7 900 000 pixels.  

o try to reuse identical backgrounds (such as a black 
1920x1080 png image) for all menus  

o try to reuse identical button states (such as checkmarks 
for “select” or pointers for “current”) for all menus 

o limit the amount of graphics or text on a menu 
o do not let a text or graphics image extend to the full 

screen width but limit it to its own size 
o Two small blocks making up an L-shape take fewer pixels 

than one rectangular block (the transparent pixels in the 
L-shape are counted as pixels in a rectangular shape) 

o make a “static image” into a background movie. Menu 
movies do not count in the total pixel count. It may liven 
up the menus as well. 

 “current” settings do not show correctly on playback 
o check if the movies for which you set a current setting 

belong to the same movie group. All subtitle or audio 
settings in a group must adhere to the same order for all 
movies. You cannot have an English audio track as track 
1 in one movie and as track 2 in another. If that needs to 
happen the movies cannot share the same group. Also 
check the position of the button state. It may be 
different from the other states and “way off” screen. 

 “current” state not found 
o a movie menu specifies an action for a button, but the 

action (set subtitle / audio) is specified for another 
movie (especially if movie is moved to another group) 

o in the properties window the state is associated with a 
file that no longer exists or was moved or renamed 

 size exceeds the BR-25 25 GB limit 
o use a BR-50 disc to burn on 
o reduce the size to BR-25 size using a compression tool 

such as BD Rebuilder 
(http://www.videohelp.com/software/BD-Rebuilder ) 

 subtitle does not show 
o check if added to the movie properties. The .srt files are 

simply text files with timings – based on whatever frame 
rate you used. Not showing while being sure they are 
there may be a deficiency of your software bluray 
player. Check the muxed movie file first. It is one of the 

http://www.videohelp.com/software/BD-Rebuilder
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files created in \OUTPUT\BDMV\STREAMS\*.m2ts files. 
Play the right file (the BDID id during muxing tells you 
which sequence number it has – unusally the same one 
as its position in the movie list of the project tree view) 
using a movie player such as VLC. If you can enable the 
subtitles and they play in sync with the dialogue, nothing 
is wrong. Otherwise you need to figure out why those 
titles are not included. 
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Appendix C: External Tools 
Because BDSL assumes its menu and movie elements adhere to bluray 
disc specifications and doesn’t thoroughly check on these requirements,  
some of the following external tools may be found useful to convert any 
movie, subtitle or menu image to meet these requirements. Use a 
search engine on the internet to find out where they can be downloaded 
and for more specific information or help about them.  

As with most freeware tools: be careful on what links you click as most 
of their webpages are loaded with irrelevant adverts that try to redirect 
you to other commercial tools. The installation files may also lure you to 
“also install our recommendation” and before you know it a lot of 
bloatware gets installed also. 

Bluray and DVD ripping 
 MakeMKV (http://www.makemkv.com/) tool to convert blurays 

into .mkv containers, but it also allows to make a “backup” of the 
entire disc on a hard disc drive folder, removing bluray encryption. 
All movie files are stored in the BDMV/streams folder. The backup 
facility is free to use for 30 days. After that you may look at forum 
page 
http://www.makemkv.com/forum2/viewtopic.php?f=5&t=1053&p=
3548&hilit=key+code#p3548 for a renewal temporary key that lasts 
for 2 months. 

 AnyDVD HD (https://www.redfox.bz/en/anydvdhd.html) 
continuation of the Slysoft AnyDVD software that removes all 
encryption and allows a disc (DVD or bluray) to be played regardless 
of region or encryption. And files can be copied unencrypted. 

 DVDFab (http://www.dvdfab.cn/) software to rip DVDs and blurays 
and shrink them to size if needed. Trialware. 

video editing 
 The standard site for video help is www.videohelp.com and 

www.doom9.org – their pages contain many pointers to software, 
guides, forums 

 TS Doctor (http://www.cypheros.de/index_e.html) – a basic editor 
for .ts files produced by satellite receivers. It can remove audio, 
subtitle and Ceefax/teletext streams that are not wanted and 
produces a .ts file as output. Make sure that at cuts you start a new 
section with a complete (I) frame. Shareware. 

 Cuttemaran (http://www.cuttermaran.de/en/default.aspx) is a 
.mpeg-2 file editor with LPCM (wav), ac3 or DTS audio for frame-
accurate cutting (requires TEMPGEnc 2.5) and Microsoft .NET 
Framework 3.5 SP1 

 SmartCutter (http://www.fame-ring.com/) a paid ($40) editor for 
H264, AVCHD and other video formats. Frame-accurate. 

 TSSniper – A .ts file editor (http://forum.team-
mediaportal.com/threads/free-ts-mpeg2-h-264-editing-

http://www.makemkv.com/
http://www.makemkv.com/forum2/viewtopic.php?f=5&t=1053&p=3548&hilit=key+code#p3548
http://www.makemkv.com/forum2/viewtopic.php?f=5&t=1053&p=3548&hilit=key+code#p3548
https://www.redfox.bz/en/anydvdhd.html
http://www.dvdfab.cn/
http://www.videohelp.com/
file:///H:/kits/All%20kits/Bluray%20Authoring/Blu%20Disc%20Studio/www.doom9.org
http://www.cypheros.de/index_e.html
http://www.cuttermaran.de/en/default.aspx
http://www.fame-ring.com/
http://forum.team-mediaportal.com/threads/free-ts-mpeg2-h-264-editing-software.80842/
http://forum.team-mediaportal.com/threads/free-ts-mpeg2-h-264-editing-software.80842/
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software.80842/) freeware. Cuts on GOP boundaries (not frame-
accurate) 

 Handbrake (https://handbrake.fr/) – freeware. Converts videos to 
different formats (transcoder) and bluray specific aspect ratios, 
audio-pass through, .srt subtitles 

 iWisoft Free Video Converter 
(http://www.iwisoft.com/videoconverter/) freeware – editor and 
transcoder that can convert between encodings, and has some basic 
editing (trim, crop). 

audio editing 
 WAV to AC3 Encoder 

(https://github.com/wieslawsoltes/wavtoac3encoder) – freeware 
tool to convert uncompressed .wav (LPCM) audio files into 
compressed Dolby Digital .ac3 files.  Although both formats are 
acceptable for bluray, the .wav file can take up seven times more 
disc space than the .ac3 version of the same audio. For most ears 
the differences are neglectible (the way .mp3 files may be 
acceptable replacements for .wav). 

image (menu and button) editing 
 Gimp (https://www.gimp.org/) Freeware image editing program 

that resembles PhotoShop capability. 

 PhotoShop (http://www.adobe.com), PaintShop Pro 
(http://www.corel.com) or any other image editing tool that allows 
its files with several layers to be saved in .psd format. Commercial 
software. 
BDSL regards a button as a set of picture layers. You can make a 
button as a single .psd Photoshop file with multiple layers. 
Alternatively, you can provide each layer as separate .png file using 
strict naming conventions that show which file represents which 
layer. 

subtitle editing 
 Jubler (www.jubler.org) – freeware subtitle editor allowing you to 

create subtitles, splitting or joining titles, shifting or stretch timings, 
translate titles (side-by-side with original lines) and many other 
features 

 Subtitle Edit (http://www.nikse.dk/subtitleedit/) – freeware subtitle 
editor. Also capable of reading .sup files and change these into .srt 
files through a Tesseract ocr process. Sup files may occur when an 
.mkv or .ts file is decomposed into elements and subtitles come out 
as .sup which are pictures rather than text. It can also synchronise 
timings of one subtitle file with another that is known to be in sync 
(sync by timing). It also allows to specify some subtitles as anchor 
points (with modified correct timings) after which all other subtitles 
are given new timings to fit between those anchor points. 

http://forum.team-mediaportal.com/threads/free-ts-mpeg2-h-264-editing-software.80842/
https://handbrake.fr/
http://www.iwisoft.com/videoconverter/
https://github.com/wieslawsoltes/wavtoac3encoder
https://www.gimp.org/
http://www.adobe.com/
http://www.corel.com/
http://www.jubler.org/
http://www.nikse.dk/subtitleedit/
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MKV container production and (de)muxing tools 
 MakeMKV – see section “Bluray and DVD ripping” 

 MKVToolnix (https://mkvtoolnix.download/) – this is a freeware 
tool using mkvmerge to create Matroska mkv videocontainers from 
separate video sources. It is a sort of zip-file containing a 
videostream and multiple audio and subtitle streams together. 
Many bluray disc players but also Windows media players can play 
these files.  
An mkv file is a good candidate to check if video, audio and subtitle 
streams are in sync with one another. If your bluray player accepts 
these files and you’re not interested in menus, you may even decide 
to burn the .mkv files to a DVD or bluray data disc and forget about 
(bluray) authoring altogether. 

 tsMuxer (http://www.videohelp.com/software/tsMuxeR) – a 
freeware tool to split a .ts file into its separate components such as 
.264  (H264 video) and .ac3 (Dolby Digital audio). This “muxer” can 
both mux (put together) or demux (split into streams). It’s a 
requirement for use with BDSL to perform the muxing part of the 
process. 

 MKVExtract – (https://sourceforge.net/projects/mkvextractgui-2/) – 
freeware tool to extract elements from an MKV file. 

software video and bluray players 
 VLC player (http://www.videolan.org/vlc/) – this is a freeware tool 

that seems to play almost any format video and/or audio file, 
including mkv, ts, mpeg or mp4 video and ac3 or wav audio. It 
allows you (via right-mouse click) to select the audio or subtitle 
stream of your choice. 

 Leawo Bluray Player (http://www.leawo.com/blu-ray-player/)  – a 
freeware bluray player capable of playing blurays on a pc bluray 
device but also to play bluray file folders or .iso images on disc 
rather than a bluray disc itself. It requires Windows XP or later. 

 Nero 12 bluray player – discontinued part of commercial Nero 
burning package (available upto V12). It does allow BDSL folders to 
be played (interlaced only at 50i and 59.94i but interlaced is not 
supported by several standalone bluray disc players). 

bluray burning software 
 ImgBurn (http://www.imgburn.com) – a freeware program to burn 

a folder or .iso image to a physical disc (CD, DVD or Bluray) provided 
the files or .iso image to burn are compliant for the medium to burn 
it to. ImgBurn also allows to create an .iso file from a compliant 
folder. Hence the Blu Disc Studio output (a set of files in Bluray 
specific folders) can be converted to an .iso file or be burned 
directly to a bluray disc. 

 Nero BurningROM – commercial package including Bluray and DVD 
burning templates as well as complete suite for audio and video 
editing and bluray creation (but limited freedom in how to do this). 

https://mkvtoolnix.download/
http://www.videohelp.com/software/tsMuxeR
https://sourceforge.net/projects/mkvextractgui-2/
http://www.videolan.org/vlc/
http://www.leawo.com/blu-ray-player/
http://www.imgburn.com/
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 BD Rebuilder (http://www.videohelp.com/software/BD-Rebuilder ) 
- freeware tool to resize a bluray folder to fit a BD-25, DVD-9 or 
DVD-5 sized disc before burning. 

virtual disc drives 
 Virtual Clonedrive (https://www.redfox.bz/virtual-clonedrive.html)– 

virtual disc drive station  freeware – program that allows you to 
“play” an .iso image of a bluray disc as if it ran from a real bluray 
drive inside your computer. You can mount the .iso file and 
suddenly a new drive letter appears (such as Y:) that is “running” 
your disc. Useful program if your software player only accepts “real” 
bluray discs and cannot play a bluray folder. 

disc Cover Designers 
 Nero CoverDesigner  (www.nero.com/eng/downloads) – freeware 

tool to create CD, DVD and Bluray covers, booklets as well as disc 
images to print on printable discs. 

 Canon ImageGarden 
(https://printinginnovations.cusa.canon.com/pixma/my_image_gar
den) – comes on CD with a Canon printer capable of printing discs 
but can also be downloaded from the Canon website. 

 

http://www.videohelp.com/software/BD-Rebuilder
https://www.redfox.bz/virtual-clonedrive.html
http://www.nero.com/eng/downloads
https://printinginnovations.cusa.canon.com/pixma/my_image_garden
https://printinginnovations.cusa.canon.com/pixma/my_image_garden

